
 

 

 

ISY-99i & 994i Series User Guide 

April 27, 2013 

(Supporting Firmware Release 3.3.10 and above)



 -  i  - 

Table of Contents 

April 27, 2013 ................................................................................................................................. i 
(Supporting Firmware Release 3.3.10 and above) ................................................................................. i 

1 Introduction................................................................................................................................ 1 

1.1 Domestic Lighting and Power Overview ....................................................................................... 1 
1.2 What's Included ...................................................................................................................... 2 
1.3 Requirements & Recommendations ............................................................................................ 2 
1.4 The ISY Front Panel .................................................................................................................. 2 
1.5 The ISY Rear Panel ................................................................................................................... 3 

2 Installation .................................................................................................................................. 5 

2.1 Hardware Installation ............................................................................................................... 5 
2.2 Connecting to the ISY from a Local PC ......................................................................................... 5 
2.3 The HTML Interface ................................................................................................................. 8 
2.4 Launching the Administrative Console ....................................................................................... 11 

3 The Administrative Console ...................................................................................................... 12 

3.1 Basic Configuration ................................................................................................................ 12 
3.1.1 Setting the User ID and Password .................................................................................. 12 
3.1.2 Setting the Time and Location ....................................................................................... 12 
3.1.3 Keyboard Navigation ................................................................................................... 13 
3.1.4 Themes ..................................................................................................................... 14 

3.2 The Main Tab........................................................................................................................ 15 
3.2.1 Adding INSTEON Devices .............................................................................................. 15 
3.2.2 Adjusting Settings on INSTEON Devices ........................................................................... 18 
3.2.3 Creating INSTEON Scenes ............................................................................................. 20 
3.2.4 Organizing INSTEON Devices and Scenes ......................................................................... 23 
3.2.5 Controlling INSTEON Devices and Scenes ......................................................................... 24 
3.2.6 Other Functions (Restore, Disable, Query, & more) ........................................................... 25 

3.3 The Programs \ Details Tab ..................................................................................................... 25 
3.3.1 The Basics of ISY Programs ............................................................................................ 26 
3.3.2 Creating Your First Program .......................................................................................... 26 
3.3.3 Building Your Programs ................................................................................................ 30 
3.3.4 Program Schedules ...................................................................................................... 33 
3.3.5 Conditions ................................................................................................................. 34 
3.3.6 Program Actions ......................................................................................................... 36 
3.3.7 Program Folders ......................................................................................................... 39 
3.3.8 Other Functions .......................................................................................................... 40 

3.4 The Programs \ Summary Tab .................................................................................................. 41 
3.5 Variables.............................................................................................................................. 42 

3.5.1 Creating Variables ....................................................................................................... 42 
3.5.2 Using the Status of Variables in Programs ........................................................................ 43 
3.5.3 Modifying Variables in Programs .................................................................................... 43 
3.5.4 Using Variables in Notifications ..................................................................................... 44 



 -  ii  - 

3.6 The Integrated IR Receiver ...................................................................................................... 45 
3.6.1 Using the 40 Default IR Codes ....................................................................................... 45 
3.6.2 Using the IR Learning Mode .......................................................................................... 46 

3.7 Notifications ......................................................................................................................... 47 
3.7.1 Adding Recipients & Changing Server Settings .................................................................. 47 
3.7.2 Custom Notifications ................................................................................................... 48 

3.8 Interfacing with the Elk ........................................................................................................... 50 
3.9 Optional Modules .................................................................................................................. 52 

3.9.1 Network Module ........................................................................................................ 52 
3.9.2 Climate Module .......................................................................................................... 55 
3.9.3 Electricity Module ....................................................................................................... 57 
3.9.4 Open Auto Demand / Response Module .......................................................................... 58 
3.9.5 ELK Security Module .................................................................................................... 58 
3.9.6 X10 Module ............................................................................................................... 59 
3.9.7 The Irrigation Module .................................................................................................. 60 

3.10 Diagnostics ........................................................................................................................... 61 
3.10.1 The Event Viewer ........................................................................................................ 61 
3.10.2 System Status ............................................................................................................. 62 
3.10.3 PLM Info/Status .......................................................................................................... 62 
3.10.4 PLM Links Table .......................................................................................................... 62 
3.10.5 Show Device Links Table ............................................................................................... 62 
3.10.6 Show ISY Links Table .................................................................................................... 63 
3.10.7 Scene Test ................................................................................................................. 63 
3.10.8 Query INSTEON Engine ................................................................................................ 63 

4 Glossary .................................................................................................................................... 63 

5 Index ......................................................................................................................................... 66 

Appendix A:  Front and Rear Panel LEDs ........................................................................................ 67 

Appendix B:  Factory Reset ............................................................................................................. 69 

Appendix C:  Replacing / Upgrading Your SD Card ......................................................................... 71 

Appendix D:  Upgrading Your Firmware ......................................................................................... 75 

Appendix E:  Assigning a Static IP Address to the ISY...................................................................... 77 

Appendix F:  INSTEON Device Notes ............................................................................................... 79 

Appendix G:  Sample ISY Programs ................................................................................................ 83 

Appendix H:  Troubleshooting INSTEON Communication Issues .................................................... 85 

 



 -  iii  - 

Table of Figures 

Figure 1  ISY Front Panel ......................................................................................................................... 3 
Figure 2  ISY-99i Series Rear Panel ............................................................................................................ 3 
Figure 3  ISY-994i Series Rear Panel .......................................................................................................... 4 
Figure 4  Login Window .......................................................................................................................... 7 
Figure 5  Help/About Menu..................................................................................................................... 7 
Figure 6  My URL ................................................................................................................................... 7 
Figure 7  ISY’s HTML Interface ................................................................................................................. 9 
Figure 8  Admin Console/File Menu ........................................................................................................ 12 
Figure 9  Setting the Clock .................................................................................................................... 13 
Figure 10  Change Theme Menu ............................................................................................................ 14 
Figure 11  Theme Samples .................................................................................................................... 14 
Figure 12  The Main Tab ....................................................................................................................... 15 
Figure 13  The Link Management Menu................................................................................................... 16 
Figure 14  Linking Options..................................................................................................................... 16 
Figure 15  New INSTEON/A10/X10 Screen ............................................................................................... 18 
Figure 16  File/Automatic Writes Menu ................................................................................................... 19 
Figure 17  Pending Changes Icon ............................................................................................................ 19 
Figure 18  Write Updates to Device ........................................................................................................ 20 
Figure 19  New Scene Screen ................................................................................................................. 21 
Figure 20  Choose Scene Screen ............................................................................................................. 21 
Figure 21  Cross-Linking ........................................................................................................................ 22 
Figure 22  Multiple Responders with 1 Controller ...................................................................................... 22 
Figure 23  Controller Properties ............................................................................................................. 23 
Figure 24  Scene Controls ..................................................................................................................... 24 
Figure 25  Creating a Program ............................................................................................................... 26 
Figure 26  Naming a Program ................................................................................................................ 27 
Figure 27  IF Statement ........................................................................................................................ 27 
Figure 28  Schedule at Sunset ................................................................................................................ 27 
Figure 29  Adding to the IF Statement ..................................................................................................... 28 
Figure 30  Adding a THEN Statement ...................................................................................................... 28 
Figure 31  Adding to the THEN Statement ................................................................................................ 28 
Figure 32  Highlight “Time is Sunset” ...................................................................................................... 29 
Figure 33  Updating the Schedule ........................................................................................................... 29 
Figure 34  Adding an ELSE Statement ...................................................................................................... 30 
Figure 35  Adding to the THEN Statement ................................................................................................ 30 
Figure 36  Additional Program Buttons .................................................................................................... 31 
Figure 37  Grouping Conditions .............................................................................................................. 31 
Figure 38  Adding Program Comments .................................................................................................... 32 
Figure 39  Temporarily Disable a Program ................................................................................................ 32 
Figure 40  Display of Disabled Programs .................................................................................................. 32 
Figure 41  Display of Unsaved Programs with Changes ............................................................................... 33 
Figure 42  Schedule Screen – Time Range ................................................................................................ 33 
Figure 43  Schedule Screen – Time & Day ................................................................................................ 34 
Figure 44  Status Condition – 100% Bright................................................................................................ 35 
Figure 45  Status Condition – Any Brightness ............................................................................................ 35 
Figure 46  FAST ON Condition ................................................................................................................ 36 
Figure 47  X10 Condition ...................................................................................................................... 36 
Figure 48  WAIT Action ......................................................................................................................... 38 



 -  iv  - 

Figure 49  RANDOM Action ................................................................................................................... 38 
Figure 50  Flash Lights ON and OFF ......................................................................................................... 39 
Figure 51  Folder Conditions .................................................................................................................. 40 
Figure 52  ISY Toolbar .......................................................................................................................... 41 
Figure 53  Counter Variable................................................................................................................... 43 
Figure 54  Increment a Variable by 1 ....................................................................................................... 44 
Figure 55  Set a Variable’s Initial Value .................................................................................................... 44 
Figure 56  Email Based on Motion Sensor Trigger ...................................................................................... 44 
Figure 57  Email Recipients Screen ......................................................................................................... 48 
Figure 58  Motion Sensor Email ............................................................................................................. 49 
Figure 59  Scheduling an Email .............................................................................................................. 49 
Figure 60  ELK Configuration Screen ....................................................................................................... 50 
Figure 61  ELK Status Screen .................................................................................................................. 51 
Figure 62  Import Lighting Data .............................................................................................................. 52 
Figure 63  Networking Actions ............................................................................................................... 54 
Figure 64  Weather Stations .................................................................................................................. 55 
Figure 65  Local Weather Information ..................................................................................................... 56 
Figure 66  Using Climate Conditions ........................................................................................................ 57 
Figure 67  Electricity Meter Settings Screen ............................................................................................. 57 
Figure 68  Electricity Conditions ............................................................................................................. 58 
Figure 69  ELK Resources ...................................................................................................................... 58 
Figure 70  Using ELK Conditions ............................................................................................................. 59 
Figure 71  ELK Actions .......................................................................................................................... 59 
Figure 72  Adding and X10 Device .......................................................................................................... 60 
Figure 73  WeatherBug Settings ............................................................................................................. 61 
Figure 74  ISY Front Panel ..................................................................................................................... 67 
Figure 75  ISY with Cover Removed ........................................................................................................ 72 
Figure 76  Assigning a Static IP Address ................................................................................................... 77 

 



 -  1  - 

1 Introduction 

Thank you for purchasing a Universal Devices, Inc. ISY Series device.  The ISY provides 

central control of home automation devices in a residence and is designed to play the role of 
home automation device controller in any domestic UPnP network.   

Home automation devices controlled by the ISY include: INSTEON lighting devices, X10 
lighting and power devices, fans, curtain sweeps, thermostats, motion sensors, intruder 
alarms, power consumption monitors and many others.  ISY interfaces securely to both 
wireless and wire line local area networks and the internet.  Homes equipped with ISY-
controlled systems can be managed via a browser interface from any smartphone or other 
internet browser from any location with internet access. 

With the ISY, you can: 

 Program, configure and manage your INSTEON and X10 devices 
 Automate your home using sophisticated timers, triggers, and macros 
 Conserve energy in your home 
 Remotely control your home using the ISY’s web interface 
 And, MUCH more! 

This User Guide will help you install and configure your ISY and will provide links to 
additional resources that you may find helpful.  Please read through this guide before 
beginning installation. 

1.1 Domestic Lighting and Power Overview 

In order to make the most of the capabilities of the ISY, the user will find that a basic 
understanding of the devices to be controlled is helpful.  This section contains a review of 
the salient characteristics of the types of device that the ISY can control.  

When lights or power outlets are automated in a residence, the devices involved will 
almost always use INSTEON or X10 protocols.  Such devices include light switches, power 
sockets, wired and remote controllers and IR receivers.  Although INSTEON or X10 
protocols can coexist in the same device (often referred to as dual-band), the way each of 
the protocols operates is quite different.  The ISY controls both together so they can form a 
managed lighting solution that is simple to operate and easy to enhance. 

Following is an overview of the INSTEON and X10 protocols.  Please refer to Section 
4 Glossary for a detailed description of each of these protocols. 

INSTEON:  An integrated network protocol that combines wireless radio frequency (RF) 
with the home's existing electrical wiring.   This dual-mesh network approach means 
INSTEON is faster and more reliable than X10.  INSTEON is a peer-to-peer network - its 
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devices do not require network supervision.  For straightforward applications an INSTEON 
network can operate effectively without a central controller. 

X10:  A protocol that primarily uses power line wiring for signaling and control.  X10 switches 

operate by responding to the physical control (switch) on the device itself or by responding to an 

X10 control signal addressed to that switch from an X10 signal source elsewhere in the 

residence’s electrical system.  Typically, X10 devices are either controllers that generate X10 

signals or light switches or electrical sockets that respond to X10 signals.  Although, as a 

protocol, X10 lacks the capabilities and operational reliability of INSTEON, X10 switches 

remain the preferred way to control devices that may create surges at power-on such as 

traditional fluorescent lights and general-purpose electrical sockets. 

1.2 What's Included 

Depending on the package you purchased, you received the following:  

 ISY-99i or 994i Series device  
 Two (2) Standard Category 5e Ethernet patch cables 
 Quick Start guide 

1.3 Requirements & Recommendations 

In addition to the ISY package, the following are required: 

PowerLinc Modem (PLM):  a Smarthome 2412S (now discontinued) or 2413S is required 
to communicate to and from your INSTEON devices.  The 2413S can be purchased at 
Smarthome as follows:  http://www.smarthome.com/2413s.html 

A Java-enabled web browser (such as Internet Explorer or FireFox):  is required to 
launch the ISY’s Administrative Console.  The latest version of Java can be downloaded 
from:  http://www.java.com/getjava 

A DHCP-enabled router or other DHCP-enabled network:  is recommended for 
installation and configuration ease.  If using a non-DHCP-enabled router, or a direct 
connection to a computer which is not a DHCP server using an Ethernet cross-over cable 
(not included), the following are required in order to configure the ISY's network 
parameters:  

 For the ISY-99i series device you will need a null-modem serial cable and available 
serial port (or USB to serial adapter) on your computer. 

 For the ISY-994i series device you will need a micro USB cable and available USB port 
on your computer. 

1.4 The ISY Front Panel 

The ISY’s front panel has several elements with which you should become familiar:  

http://www.smarthome.com/2413s.html
http://www.java.com/getjava
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Figure 1  ISY Front Panel 

 The LEDs on the front of your unit show the current status of your ISY.  They can also 
assist with troubleshooting any issues you may be having.  For more information on the 
ISY’s front panel LEDs, please see Appendix A:  Front and Rear Panel LEDs. 

 A Reset Button is located on the front of your ISY.  To simply reboot your ISY, use a 
sharp object to briefly press the ISY’s recessed Reset Button.  To factory reset your ISY, 
please see Appendix B:  Factory Reset. 

 Certain ISY-99i Series Controllers include an integrated IR receiver located on the front 
of the unit.  This IR receiver can be used to control your home using an RC-5-capable 
universal remote control. 

 Your ISY may also include an externally accessible SD card slot.  Please DO NOT 
remove the SD card while the ISY is running.  ISY’s without an external SD slot must be 
opened in order to replace the SD card.  For instructions on replacing your SD card, 
please see Appendix C:  Replacing / Upgrading Your SD Card. 

1.5 The ISY Rear Panel 

The rear panel of the ISY features the following: 

 

Figure 2  ISY-99i Series Rear Panel 

http://www.universal-devices.com/mwiki/index.php?title=File:QSG_Rear_Panel.png
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Figure 3  ISY-994i Series Rear Panel 

The Power port is used to provide power to the ISY with an AC adapter.  This may not be 
necessary if using a 2412S PLM, but is required when using a 2413S PLM.  Please use an AC 
adapter that provides 5V DC, a minimum of 300mA, and is center terminal positive.   

Even if using a 2412S PLM, there are several reasons why you may want to use a separate 
AC adapter instead of power provided by the PLM: 

 An AC adapter can be plugged into a UPS to help protect the ISY from power outages 
and power surges.  The PLM cannot be plugged into a UPS. 

 Powering the ISY using a separate AC adapter may help improve (by a small amount) 
the signal strength of the INSTEON PLM. 

Port A is an RJ-45 connector used to attach your INSTEON PLM to the ISY.  This allows the 
ISY to communicate with your INSTEON devices.  Please use a standard Category 5e 
network patch cable (included) to connect your ISY to the PLM.  WARNING:  DO NOT use 
this port to connect to an Ethernet router or switch. 

Port B (ISY-99i Series ONLY) is a 9-pin female RS-232 serial port used for initial 
configuration for users without a DHCP-enabled network, or for advanced troubleshooting.  
Please use a standard 9-pin null-modem serial cable (included with the PRO version) to 
connect your ISY to your PC’s serial port. 

The Monitor port (ISY-994i Series ONLY) is a micro USB port used for initial 
configuration for users without a DCHP-enabled network, or for advanced troubleshooting.  
Please use a standard micro USB cable to connect your ISY to an available USB port on your 
PC.  

The Network jack is used to attach the ISY to your Ethernet network.  Use a standard 
Category 5e network patch cable (included) to plug your ISY into an available network jack 
on your router or switch.  If connecting directly to a PC for programming, please use an 
Ethernet cross-over cable (not included).  WARNING:  DO NOT use this port to connect to 
an INSTEON PLM. 
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2 Installation 

Installation of the ISY is completed in several easy steps.  The following instructions 
assume that you are installing the ISY on a DHCP-enabled network (true in the vast 
majority of cases) and are using a Windows-based PC to connect to the ISY. 

If you do not have a router or other DHCP-enabled network to plug the ISY into and plan on 
using a direct connection to a PC, or if you are using an OS other than Windows, please see 
our online Wiki for more advanced installation instructions:  http://wiki.universal-
devices.com  

2.1 Hardware Installation 

Installation of the ISY hardware is completed in several easy steps: 

1. Plug your ISY into your home network.  Simply plug one end of an included Ethernet 
cable into the ISY’s Network jack.  Plug the other end of the cable into your router or 
network switch/hub. 

2. Plug your ISY into the INSTEON PLM.  Connect one end of the included Ethernet cable 
and attach it to Port A on the ISY.  The other end of the cable plugs into your INSTEON 
PLM. 

3. Apply power to the PLM and ISY by plugging it into a standard power outlet.  Do not 
plug the PLM into a UPS or surge protector of any kind.  If possible, avoid plugging the 
PLM into an outlet on the same circuit as other electronic devices to ensure optimal 
communications with your INSTEON devices.  For information on troubleshooting 
INSTEON communication issues, and tips on creating a reliable INSTEON network, see 
Appendix H:  Troubleshooting INSTEON Communication Issues. 

Once power is supplied to your ISY, it will automatically boot up.  The RX, TX, and Mem 
LEDs may flash briefly, and the PWR LED should be on steady.  The two small green LEDs 
on the ISY’s Network jack should be on (indicating a good network connection) and may 
flash (indicating network activity). 

2.2 Connecting to the ISY from a Local PC 

There are several requirements for connecting to your ISY from a PC on your network: 

 Java:  Please ensure that the latest edition of Java is installed on your computer. The 
latest Java downloads may be found at: 

http://www.java.com/getjava  

http://wiki.universal-devices.com/
http://wiki.universal-devices.com/
http://www.java.com/getjava
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 Web Browser:  Please be sure your PC is running a Java-enabled web browser, such as 
Internet Explorer or FireFox. 

As shipped from the factory, the ISY is configured to obtain an IP address via DHCP.  There 
are a few easy ways to connect to your ISY and find its local URL: 

Option1 (ISY-994i Series ONLY):  In most cases, the quickest and easiest way to connect to 
the ISY for the first time on a Windows PC is to open a web browser and type in the 
following URL: 

http://isy 

The default login information is: 

Username:  admin 
Password:  admin 

Option 2:  You can also double-click the My Lighting icon that you’ll find in your PC’s My 
Network Places (in Windows XP) or Network (in Windows 7 or Vista).   

The My Lighting icon requires that Windows is configured to discover UpnP devices on 
your network.  If you do not see a My Lighting icon, look for an option on the left-hand pane 
called “Show icons for networked UPnP devices”.  Please click this option to allow Windows 
to automatically find the ISY on your network.  In Windows 7 and Vista, please be sure 
Network Discovery is turned on. 

Please add this page to your web browser’s Favorites for easy access in the future.   

Option 3:  If the above options are not working for you, or if you are on a non-Windows 
platform, please visit the following URL: 

http://isy.universal-devices.com/99i  

This will launch a UDI-hosted version of the ISY’s Administrative Console and attempt to 
locate the ISY on your network. 

Option 4:  To install the ISY’s Java applet on your PC and create an icon on your desktop, 
visit the following URL:   

http://isy.universal-devices.com/99i/admin.jnlp  

Like option 3, this will open the ISY’s Administrative Console directly and attempt to locate 
the ISY on your network.  In the future, simply double-click the desktop icon to launch the 
ISY’s Administrative Console. 

http://isy/
http://isy.universal-devices.com/99i
http://isy.universal-devices.com/99i/admin.jnlp
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Once you launch the Administrative Console, you will be presented with a login window 
asking you to authenticate to your ISY.  The default login information is: 

Username:  admin 
Password:  admin 

 

Figure 4  Login Window 

To find your ISY’s login URL, click the HELP -> ABOUT pull down menu: 

 

Figure 5  Help/About Menu 

Then look for the address listed after “My URL.” 

 

Figure 6  My URL 

Type this into your web browser to quickly connect to your ISY in the future.  Feel free to 
add this URL to your web browser’s Favorites. 

http://www.universal-devices.com/mwiki/index.php?title=File:QSG_Authenticate.gif
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When using DHCP, in some cases your ISY may receive a new IP address from your router 
(or other DHCP server).  If this happens, you may not be able to use the old address to 
connect to your ISY.  To find out your ISY’s new address, simply double-click your My 
Lighting icon or visit the following URL to automatically find the ISY (and its new address) 
on your network: 

http://isy.universal-devices.com/99i  

If you wish to assign your ISY a static IP address, please see Appendix E:  Assigning a Static 
IP Address to the ISY. 

Once you find your URL, you are ready to start using the ISY.  To connect to the ISY, launch 
your web browser and type the URL into the address bar.  You will then be asked to 
authenticate.  Again, the default login information is: 

Username:  admin 
Password:  admin 

Once you login you will be presented with the ISY’s HTML interface. 

2.3 The HTML Interface 

The ISY’s HTML interface provides an easy way to interact with your ISY.  The HTML 
interface does not require Java, and is accessible from just about any web browser – 
including mobile phones and other devices!   

http://isy.universal-devices.com/99i
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Figure 7  ISY’s HTML Interface 

You won’t be able to do much until you start configuring your ISY, but here is a summary of 
what you can do with the HTML Interface: 

The Home Tab: 

My Devices & Scenes – This is where you will find a list of all INSTEON devices and scenes 
you have on your ISY.  You can control your devices and scenes as well as check their 
current states.  Use this page to turn lights and other devices on or off, adjust your 
thermostats, and much more.   

My Devices – Same as My Devices and Scenes, but this will show only your devices.   

My Scenes – Same as My Devices & Scenes, but this will show only your scenes.  You will 
learn more about Scenes in the Section 3 The Administrative Console.   

My Weather – This section, if shown, is where you can see weather information available 
to your ISY.  This option is only available if the optional Climate Module has been 
installed on your ISY.  More information is available in the section of this guide titled 
3.9.2  Climate Module. 
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My Programs – By clicking this link you can view the status of any Programs you have 
stored on your ISY and also control them.  You will learn more about Programs in the 
section titled 3.3 The Programs \ Details Tab. 

Networking Resources – This section, if shown, is where you can view and control any 
network resources you may have configured on your ISY.  This option is only available if 
the optional Network Resources Module has been installed on your ISY.  More 
information is available in the section of this guide titled 3.9.1 Network Module. 

Networking WOL – This section, if shown, is where you can view and control any Wake-
On-LAN entries you may have configured on your ISY.  This option is only available if the 
optional Network Resources Module has been installed on your ISY.  More information 
is available in the section of this guide titled 3.9.1 Network Module. 

Elk – This section, if shown, is where you can view and control any resources available 
from your ELK security system.  This option is only available if the optional ELK 
Security Module has been installed on your ISY.  More information is available in the 
section of this guide titled 3.9.5 The ELK Security Module.   

Variables – This section is where you can view and control any variables you have 
configured on your ISY.  More information is available in the section of this guide titled 3.5 
Variables. 

Under The Settings tab: 

SubDevices – This option allows you to show or hide SubDevices in the HTML interface.  
SubDevices are typically secondary buttons, such as non-load controlling buttons on 
KeypadLincs, etc. 

Controllers  – This option allows you to show or hide Controller-only devices from the 
HTML interface, such as RemoteLincs and ControlLincs. 

Disabled – This option allows you to show or hide disabled devices from the HTML 
interface.  Devices can be disabled through the Admin Console. 

Max Width – This option sets the width of the HTML interface. 

Local Caching – Enabling this option tells the HTML interface to cache the node list to your 
system, potentially improving performance.  If this option is enabled, however, you will 
need to periodically hit “Clear Cache” to refresh the interface and see changes to your node 
list. 

Clear Cache – This button clears the disk and memory cache of the HTML interface 
allowing you to see the latest changes to your node list. 
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Install Admin Console – This button installs a local copy of the Admin Console applet to 
your system, creating a desktop icon so you can launch the Admin Console quickly and 
easily. 

Finally, the Admin Console tab launches the ISY’s Administrative Console, which does 
require Java.  The Administrative Console is where you will be configuring your ISY, adding 
INSTEON devices, creating Programs, configuring the optional IR interface, and MUCH 
more.  

There may be other links available in the HTML interface as well depending on how your 
ISY is configured, and what optional modules you may have purchased.   

2.4 Launching the Administrative Console 

The Administrative Console is where you will spend most of your time configuring and 
tuning the ISY, programming your INSTEON devices, etc.  Java is required. 

The best way to launch the Admin Console is from the following URL (requires internet 
access): 

http://isy.universal-devices.com/99i  

You can also install a copy of the Admin Console’s applet on your local PC (icon created on 
desktop) by launching the following URL: 

http://isy.universal-devices.com/99i/admin.jnlp  

Finally, you can also launch the Admin Console by clicking the link located on the ISY’s 
HTML Interface. 

Once launched, you will again be asked to authenticate to your ISY.  The default login 
information is: 

Username:  admin 
Password:  admin 

In the future you may go directly to the ISY’s Administrative Console by appending /admin 
to the URL.  For example: 

http://192.168.0.101/admin 

http://isy.universal-devices.com/99i
http://isy.universal-devices.com/99i/admin.jnlp
http://192.168.0.101/admin
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3 The Administrative Console 

The Administrative Console is divided into several tabs, each used to configure different 
aspects of your ISY. 

3.1 Basic Configuration  

Before getting started, it’s important to configure a few basic things on the ISY. 

3.1.1 Setting the User ID and Password 

For security reasons, please change the default username and password used to connect to 
your ISY.  Choose the Set Userid/Password option with the Administrative Console’s File 
pull-down menu as shown below. 

      

Figure 8  Admin Console/File Menu 

When choosing your new username and password, please consider the following: 

 Both the User ID and password must be entered 
 User ID and passwords are case sensitive 
 The ID and password must be between 3 and 10 characters 
 The following characters are NOT allowed:  < > / ; & 

3.1.2 Setting the Time and Location 

Click the ISY’s Configuration tab, then the System sub-tab, to set your time (used for 
Program schedules) and location (used to calculate sunrise/sunset times).   
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Figure 9  Setting the Clock 

Please be sure to check the Daylight Saving option if applicable in your area.   

Also feel free to check and configure the NTP Server option if your ISY is able to access the 
internet.  The ISY will periodically sync its clock with the specified NTP server to ensure 
accurate time.  We recommend syncing every 24 hours, as too frequent connection 
attempts can result in the NTP server refusing the ISY’s request. 

After adjusting your settings, please be sure to hit the SAVE button. 

3.1.3 Keyboard Navigation 

Please note that pull-down menus are accessible via keyboard shortcuts as follows: 

 Alt-F to access the File menu 
 Alt-L to access the Link Management menu 
 Alt-T to access the Tools menu 
 Alt-H to access the Help menu 

Once a pull-down menu is opened, use your arrow keys to navigate and the enter key to 
select a menu item.  You can also hit letter keys to access many menu items quickly – look 
for menu items which contain underlined letters.  For example, within the File pull-down 
menu, hit the B key to open the Backup ISY dialog box. 
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3.1.4 Themes 

You can choose between several different predefined color schemes to suit your 
preference.  To select a different theme click the File pull-down menu, then Themes, then 
Theme Colors and choose your scheme.  Please note that the Administrative Console must 
be closed and re-opened for your theme change to take effect.   

 

Figure 10  Change Theme Menu 

 

Desert Grey 

  

High Contrast Default 

  

Figure 11  Theme Samples 
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3.2 The Main Tab 

The Main tab is where you can add, configure, and manage your INSTEON devices.   

 

Figure 12  The Main Tab 

The left-hand pane displays a hierarchy of folders, devices, and scenes contained within 
your ISY.  The right-hand pane displays detailed information on what you have selected on 
the left. 

3.2.1 Adding INSTEON Devices 

Adding INSTEON devices to the ISY can be done via several different methods.  Some 
devices require a particular method; other devices can be added to the ISY in multiple 
ways.  For more specific information, see Appendix F:  INSTEON Device Notes. 

Adding devices to the ISY is done through the Link Management pull-down menu.  Within 
that menu are several different options: 



 -  16  - 

 

Figure 13  The Link Management Menu 

Start Linking.  The majority of INSTEON devices can be added using this method.  Once 
this option is selected, simply go to each INSTEON device installed and hold the SET button 
for 3-5 seconds.  The ISY will then see each device, and add it to the device list.   

As you hold the SET button on each device, you will see the device added to the left-hand 
pane.  Once you are finished adding devices, hit the FINISH button which will complete the 
process.  Adding devices to the ISY can take anywhere from a few seconds to minutes per 
device, depending on how many existing links are contained within each device.  Please be 
patient. 

Before adding devices to the ISY, it’s important to understand the 3 different options 
presented: 

 

Figure 14  Linking Options 

http://www.universal-devices.com/mwiki/index.php?title=File:QSG_Linking_In_Progress.gif
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 Remove Existing Links.  This option will add the device to the ISY, and also remove 
any existing links in the device.  This is the default and the best option to choose if you 
would like a clean start, or if it is a brand new device. 

 Add Devices Found in Links and Remove Existing Links.  This option will not only 
add the particular device you press the SET button on, but will also add any devices that 
the particular device is linked to.  Once complete, it will then remove any links 
contained within the devices.  This helps save some time if you have a device you have 
already linked with other devices, but still clears out all links to give you a fresh start. 

 Add Devices Found in Links and Keep Existing Links.  The option not only adds the 
particular device you press the SET button on, but will also add any devices that the 
particular device is linked to.  It will also keep any pre-existing links between devices, 
and build ISY scenes out of those links.  This is the best option to choose if you’d like to 
preserve all existing links between devices. 

Link a ControLinc, Link a RemoteLinc, Add Button to IRLinc Receiver/Transmitter, Add 
Sensor to EZSnSRF Add X10 Device to EZX10RF, etc..  These are specific options used to add 
the respective devices to the ISY.  If you are adding one of these devices to the ISY, choose 
the corresponding menu option and follow the on-screen instructions. 

 Advanced Options.  This option adjusts the method used when the ISY is programming 
your devices.  Please do not touch this option unless instructed by a UDI support rep. 

 New INSTEON Device.  This method works much like the Start Linking method, with 
one exception – instead of hitting the SET button on each device, you must type in the 
device’s INSTEON address.  The ISY will then initiate communications with the device in 
order to add it to your system.  In most cases you can leave the Device Type option set 
to Auto Discover, but some devices may require you to specify the Device Type.  For 
more information please see:  Appendix F:  INSTEON Device Notes. 

NOTE:  This option will be titled “New INSTEON/X10/A10 Device if the optional X10 
Module is installed.  Please see 3.9.6 X10 Module for more information. 
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Figure 15  New INSTEON/A10/X10 Screen 

3.2.2 Adjusting Settings on INSTEON Devices 

Some INSTEON devices have settings that can be changed through the ISY.  For example, 
dimmable devices have On Levels and Ramp Rates that can be adjusted.   

 On Levels are the brightness levels at which a device is turned on when pressed (25%, 
75%, etc.).   

 Ramp Rates are the speeds at which a device is turned on when activated.  Use a 
slower ramp rate to ramp a light on more slowly when pressed. 

To adjust settings on a device, simply click to select a device.  Available settings will be 
displayed on the right-hand pane. 

Some devices may have other options available.  To find out more information for a 
particular device, please see Appendix F:  INSTEON Device Notes. 

Making changes to INSTEON devices, whether adjusting settings or creating/modifying 
Scenes (see 3.2.3 Creating INSTEON Scenes), can be a time consuming process.  While 
making minor changes can be relatively quick, making changes to large scenes (for 
example) can take many minutes. 

PRO Series ONLY: 

By default, the ISY is set to automatically write updates to devices as you make changes in 
the Admin Console.  In some cases, you might prefer to queue your changes and write all 
changes to devices at a more convenient time. 
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To toggle this option, click the FILE menu: 

 

Figure 16  File/Automatic Writes Menu 

Automatic Writes to Devices (PRO Series ONLY).  When this option is on, changes are 
written automatically to devices.  Toggle this option off to disable automatic writes.  When 
toggled back on, all pending changes will be sent to devices. 

Automatic Writes to Battery Powered Devices (PRO Series ONLY).  This option toggles 
automatic writes only for battery powered devices.  Most battery powered devices need to 
be manually set to linking mode to accept changes, so utilizing this option to queue up  
multiple changes can help save time. 

Devices that have pending changes waiting to be written are marked with a green icon in 
the device tree as pictured here: 

 

Figure 17  Pending Changes Icon 
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To write all pending changes for a single device (without turning Automatic Writes back 
on), simply right-click the device and choose Write Updates to Device: 

 

Figure 18  Write Updates to Device 

3.2.3 Creating INSTEON Scenes 

Scenes are collections of INSTEON devices that react to and with one another in various 
ways.  Scenes are comprised of both Responders and Controllers. 

Responders are devices contained within scenes that only respond to commands issued to 
the scene.  For example, a lamp module with a table lamp attached would likely be a 
Responder to the scene.  When the scene is turned on, the lamp module might turn on.  
When the scene is turned off, the map module might turn off.  Responders are colored blue 
within a scene. 

Controllers not only respond to commands issued to the scene, the also control the scene.  
An example of a Controller might be a button located on a Keypad – when that Keypad 
button is pressed, all members of the scene will respond as programmed.  Controllers are 
colored red within a scene. 
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To create a Scene, simply click the New Scene option under the Link Management pull-
down menu, or click the New Scene button on the ISY’s toolbar. 

 

Figure 19  New Scene Screen 

Name the Scene accordingly, click OK, and your scene will appear in the left-hand pane.   

To add devices to a scene, simply right-click a device, choose Add To Scene, and choose the 
appropriate Scene.  You can also hold the CTRL key down, click multiple devices, then right-
click and choose Add To Scene to add multiple devices at once. 

 

Figure 20  Choose Scene Screen 

If appropriate, the ISY will ask you if the device should be added to the Scene as a 
Responder or a Controller.  Some devices (typically devices without buttons) cannot be 
Controllers. 

To remove devices from a scene, simply right-click a device from within a scene and choose 
Remove from Scene.  To remove an entire scene, simply right-click the scene and choose 
Remove Scene. 
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One example of a scene might be a group of 2 devices that control the same light – typically 
called a “virtual 3-way circuit”.  For example, you might have 2 switches in your kitchen 
that you’d like to control your kitchen table light.  One switch is physically attached to the 
kitchen table light, but you’d like the other switch to control it as well.  In this case you 
would add both devices as Controllers.  In the scene below, both devices in the scene are 
Controllers (shown below in red).  This is commonly called “cross-linking.” 

 

Figure 21  Cross-Linking 

Another example of a scene might be a keypad button that you want to control multiple 
lights in a room.  When the keypad button is turned on, you might want multiple devices to 
turn on at various levels to create a lighting “mood”.  When the keypad button is turned off, 
the devices would all turn off.  In the screenshot below, the KitchenDinner scene contains 
multiple Responder devices (in blue) with a single Controller (in red): 

 

Figure 22  Multiple Responders with 1 Controller 

Scenes can contain multiple Controllers, and each Controller can be programmed to set 
Responders to various ON levels and ramp rates. 

ON Levels are levels at which a Responder is turned on when activated (25%, 75%, etc.).  
Devices can have multiple ON Levels (one per Controller).  Relay devices can only be ON or 
OFF. 

Ramp Rates (dimmable devices only) are the speeds at which a device is turned on when 
activated.  Use a slower ramp rate to ramp a light on more slowly. 

To set the properties of a scene, click on a Controller within a scene.  On the right-hand 
pane will be options to set each scene member’s on levels and ramp rates used when the 
highlighted Controller is pressed.  Simply move the appropriate slider left or right to adjust 
the values.  Once the slider is released, changes will be saved to the device. 
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To set values when the ISY itself is the Controller (for example when controlled through the 
Administrative Console or through ISY Programs), click the scene itself on the left-hand 
pane. 

In the example below, when the highlighted Controller is pressed the TheaterControls1A-
Table device will turn on to 60% and the TheaterMain1 and TheaterMain2 devices will turn 
off.  All devices are set to use a 2 second ramp rate. 

 

Figure 23  Controller Properties 

There are a couple of other options available when adjusting scenes: 

Apply Changes To All Devices.  This option will merge all Responder sliders to one slider 
to make bulk changes easier.  For example, if you want all responders in a scene to turn on 
to 50%, simply check the Apply Changes To All Devices option and drag the single slider to 
50%. 

Copy Scene Attributes From...  As noted above, the ISY itself is also a Controller of every 
scene.  If a Controller within a scene should use the same values as the ISY uses when 
controlling a scene, simply click this button to copy the values from the ISY over to the 
currently selected Controller. 

NOTE:  Once programmed, scenes operate independently of the ISY – all programming is 
saved to the INSTEON devices.  If the ISY is turned off or is offline for some reason, 
programmed Scenes will still operate as expected. 

NOTE:  It’s important that all links between devices are created from within the ISY.  Avoid 
creating links manually between devices or using other software packages – unexpected 
results will occur. 

3.2.4 Organizing INSTEON Devices and Scenes 

Once added to your ISY, you can manage and organize your INSTEON Devices and Scenes in 
a variety of ways: 

Rename.  When added to the ISY, devices are named their INSTEON address by default.  If 
you right-click a device or scene, a Rename option is available to help make your devices 
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more identifiable.  You can also rename by left-clicking to highlight, then hitting the F2 key.  
A dialog box will pop up giving you several rename options if you’d like to rename 
associated devices as well. 

Folders.  Feel free to create folders to help organize your Devices and Scenes.  Folders can 
be created by either right-clicking on the Network node (located on the left-hand pane) and 
choosing New Folder, or using the New Folder icon located on the Administrative Console’s 
top toolbar.  Devices and Scenes can be dragged and dropped onto folders, or simply right-
click a Device or Scene and choose Move To Folder and select the appropriate folder to 
move it to.  Folders can also be moved within other Folders to create a nested hierarchy. 

Delete.  By deleting a Device or Scene you remove it completely from the ISY.  The ISY will 
also remove any links associated with any other Device or Scene. 

NOTE:  In order to delete a Device or Scene entirely from the node list, it must be located in 
the parent “My Lighting” folder.  So, to delete a node, be sure to move it out to “My Lighting” 
first. 

My Lighting.  Clicking the My Lighting node on the left-hand pane will display a summary 
of all your devices, their current states, their INSTEON addresses, and their device types / 
firmware versions.  You can sort by any field simply by clicking the appropriate column 
header (Name, Current State, Address, or Type). 

3.2.5 Controlling INSTEON Devices and Scenes 

The Admin Console also allows you to control your INSTEON devices and scenes.  Simply 
click on a device or scene, and appropriate controls will be shown on the bottom of the 
Console as follows: 

 

Figure 24  Scene Controls 

On.  Clicking the ON button turns the INSTEON device or scene on to its programmed On 
Level using it’s programmed Ramp Rate. 

Off.  Clicking the OFF button turns the INSTEON device or scene off using it’s programmed 
Ramp Rate. 

Fast On.  Clicking the FAST ON button turns the INSTEON device or scene on to its 
maximum (100%) level instantly (ignoring its programmed On Level and Ramp Rate). 
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Fast Off.  Clicking the FAST OFF button turns the INSTEON device or scene off instantly 
(ignoring its programmed Ramp Rate). 

Brighten.  Pressing and holding the BRIGHTEN button starts ramping up the brightness 
level of a dimmable INSTEON device.  Release the button to stop the ramp up. 

Dim.  Pressing and holding the DIM button starts ramping down the brightness level of a 
dimmable INSTEON device.  Release the button to stop the ramp down. 

LED Brightness.  Some INSTEON devices will allow you to adjust the brightness of their 
LEDs by changing this value. 

Some devices may have other controls or options available.  To find out more information 
for a particular device, please see Appendix F:  INSTEON Device Notes. 

3.2.6 Other Functions (Restore, Disable, Query, & more) 

There are several other functions available when working with INSTEON devices in the 
Administrative Console’s Main tab: 

Restore Device.  If an INSTEON device has lost all or some of its programming, you can try 
right-clicking the device and choosing Restore Device.  This will attempt to re-write all 
links in a device, recreating all scenes to match the ISY’s internal database.   

Disable Device.  If an INSTEON device will be taken offline for an extended period of time, 
it might be desirable to disable that device to stop the ISY from trying to access it.  Simply 
right-click the device you wish to disable, and choose the Disable option. 

Query.  The Query option is available when right-clicking a device or scene.  This will cause 
the ISY to communicate with the highlighted Device or Devices to find out their current 
states. 

Group Devices.  Some INSTEON devices will create multiple entries within the ISY.  For 
example, KeypadLincs have 6 or 8 nodes in the ISY (one for each button).  You can choose 
to group these nodes together by right-clicking the primary node and choosing “Group 
Devices”. 

Write Updates to Device.  If you have turned off “Automatic Writes to Devices” or 
“Automatic Writes to Battery Powered Devices” you can manually update a Device with any 
pending  changes by right-clicking it in the node list and choosing this option. 

3.3 The Programs \ Details Tab 

The Programs \ Details tab is where you can create ISY Programs.  ISY Programs are the 
true power of the ISY, where you can extend the capabilities of INSTEON and other devices 
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using timers, triggers, macros, etc.  Programs also allow you to utilize the ISY’s optional IR 
receiver, optional modules, and more. 

To open this tab, first click the Programs tab, then click the Details sub-tab.  The Programs \ 
Details screen is divided into several sections.  The left-pane is used to show your program 
hierarchy.  As you create ISY programs and folders, they will show here.  The bottom-left 
“Manage Programs” section holds several buttons used to create and manage your 
Programs. 

The top-right portion of the screen shows the details of a highlighted folder or program.  
The bottom right is where you will create and edit your Program. 

3.3.1 The Basics of ISY Programs 

ISY Programs are created using simple buttons and pull-down menus.  The ISY allows you 
to easily create simple programs, yet is flexible and sophisticated enough to allow powerful 
and complex programming. 

NOTE:  Unlike Scenes, Programs require that the ISY is online in order to function.  

There are several buttons available on the bottom-left of the Administrative Console used 
to create and manage your Programs: 

New Program.  This button will create a new ISY Program.  Once a Program is created, it 
can be edited and modified as needed. 

New Folder.  This button will create a new folder in your Program hierarchy. 

Save Changes.  The ISY requires that you SAVE your changes before they become active.  
Please be sure to save periodically as you create and edit your ISY Programs.  

Undo Changes.  If you have made changes to your ISY Programs, click the UNDO button to 
discard those changes and revert to the last time your changes were saved. 

3.3.2 Creating Your First Program 

To create a Program click the New Program button and a new program will appear.   

 

Figure 25  Creating a Program 
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The ISY will prompt you to name your program – type in something descriptive so you will 
be able to easily identify it in the future. 

 

Figure 26  Naming a Program 

Once you name your program click the IF statement to set your conditions. 

 

Figure 27  IF Statement 

VJK:  Redo screen shot. 

Once highlighted, the bottom portion of the screen allows you to set your conditions using 
simple buttons and pull-down menus.  For this example, we will create a program to turn 
your front door lights on at sunset. 

To set your sunset condition, click the SCHEDULE button and change the right-most drop 
down menu to SUNSET as shown below. 

 

Figure 28  Schedule at Sunset 

Once your Sunset condition is set, click ADD TO IF and you will see the IF statement added 
to the top portion of the screen, which shows the actual program you are creating. 
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Figure 29  Adding to the IF Statement 

Next, click on the THEN statement to highlight it.  The THEN portion of a program runs 
once the IF portion of a program is true.  At the bottom of the screen choose the device or 
scene that you want to turn on at sunset. 

 

Figure 30  Adding a THEN Statement 

This time hit the ADD TO THEN button to add the THEN statement to your program. 

 

Figure 31  Adding to the THEN Statement 

Hit the SAVE CHANGES button to save your program, and you’re done!  In just a few steps 
we’ve created a simple program to turn on your front door lights at sunset. 
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But, let’s say we wanted something slightly more sophisticated.  Say we want to turn the 
lights on 30 minutes AFTER sunset, and turn them off at 10pm.  To do that, we’ll make a 
couple of quick adjustments to the program. 

First we’ll click the “Time is Sunset” IF statement to highlight it.   

 

Figure 32  Highlight “Time is Sunset” 

Once the statement is highlighted we can edit it on the bottom of the screen.  Change the 
TIME IS pull-down mention to a FROM and change the middle numeric value to 30.  Then 
change the FOR pull-down menu to TO and change the values to 10pm as shown below: 

 

Figure 33  Updating the Schedule 

Click the UPDATE button to update the highlighted statement.  Clicking the ADD TO IF 
button would add an additional IF statement, which is not what we want to do in this case. 

The ELSE portion of a program runs one the IF statement is no longer true.  After 10pm the 
IF statement is no longer true, so the ELSE statement will run.  Next click the ELSE 
statement on the top portion of the screen to highlight it, and on the bottom portion set 
your Front Door lights to turn off. 
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Figure 34  Adding an ELSE Statement 

Click ADD TO ELSE and your final program should look like this: 

 

Figure 35  Adding to the THEN Statement 

Hit the SAVE CHANGES button in the bottom left, and your new program is complete! 

NOTE:  Always remember to hit the Save Changes button when finished creating or editing 
your programs!  Changes are not saved to the ISY until this button is pressed. 

There is a practically unlimited number of things you can do using ISY programs.  For more 
examples, see Appendix G:  Sample ISY Programs. 

3.3.3 Building Your Programs 

There are a variety of on-screen buttons to help build your Programs to suit your needs.  
Programs are not limited to one condition or action – you can add multiple IF, THEN, and 
ELSE statements to your program.  When adding multiple lines, be sure to choose AND or 
OR as appropriate.   
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When working with Programs containing multiple lines, additional buttons will appear to 
help arrange your lines and group them together with AND / OR parenthesis.   

 

Figure 36  Additional Program Buttons 

To remove a line, simply highlight it and click REMOVE LINE.  To rearrange your lines, 
highlight them and click MOVE LINE UP or MOVE LINE DOWN. 

To group conditions together, use the ADD AND (..) and ADD OR (..) buttons as shown 
below: 

 

Figure 37  Grouping Conditions 

This program will execute only if the time is 9:45pm and the BasementControls1A device is 
On OR if the time is 10:00pm and the BasementControls1A device is Off. 

Click the COMMENT button to add comments to your program as needed.  Click the 
UPDATE button to save your comment. 
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Figure 38  Adding Program Comments 

To temporarily disable a program, un-check the ENABLED box on the right-hand side of the 
screen and hit the SAVE CHANGES button.  Or simply right-click a program and choose 
Disable.   

 

Figure 39  Temporarily Disable a Program 

Disabled programs are displayed with a red X in the Program list as shown below: 

 

Figure 40  Display of Disabled Programs 

Programs that have changes and need to be saved are displayed in the program list with a 
green arrow: 
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Figure 41  Display of Unsaved Programs with Changes 

3.3.4 Program Schedules 

In the Add To Program button section, click SCHEDULE to add a Schedule to your Program.   

Schedules allow you to add IF statement based on time of day, ranges of times, sunrise/set, 
days of the week, etc. 

For example, a program that would run from 6am to 12pm: 

 

Figure 42  Schedule Screen – Time Range 
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Or a program that would run at 10pm on weekdays: 

 

Figure 43  Schedule Screen – Time & Day 

Once your Schedule statement is as intended, click the ADD TO IF button to add it to your 
program. 

3.3.5 Conditions 

In the Add To Program button section, click CONDITION to add a Condition to your 
Program.   

Conditions add other criteria to your IF statement.  When adding a Condition to your 
Program, be sure to choose if you would like it to be added as an AND or OR. 

Types of Conditions are: 

Status conditions are true if a selected INSTEON device is at the state you specify.  You can 
check to see if a device is ON, OFF, is NOT ON, is NOT OFF, if a dimmable device is at a 
specific level, if it’s greater than a specific level, etc.   

ON means a device is at 100% brightness.  So, if your program is checking to see if a 
dimmable device is on at ANY level, check to see if it is NOT OFF instead. 
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For example, to see if your kitchen light is at 100% brightness you could do the following: 

 

Figure 44  Status Condition – 100% Bright 

But, to see if the same light is on at ANY brightness you might do this instead: 

 

Figure 45  Status Condition – Any Brightness 

Control conditions trigger only if a specified switch is pressed.  The following types of 
presses are selectable (not all options available for all devices): 

ON 

OFF  

FAST ON (double-tap ON) 

FAST OFF (double-tap OFF) 

FADE UP (press and hold ON) 

FADE DOWN (press and hold OFF) 

FADE STOP (release of a press and hold) 

BRIGHT (bright button pressed) 

DIM (dim button pressed) 

For example if you want to trigger a program if your Kitchen switch is double-tapped ON 
(FAST ON) you could do the following: 
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Figure 46  FAST ON Condition 

Program conditions check to see whether or not other ISY Programs are currently True or 
False.  

X10 conditions trigger programs when X10 commands are received by the ISY.  For 
example, to run a program if an X10 M1 ON command is received: 

 

Figure 47  X10 Condition 

Variable conditions trigger programs based on the value of a defined variable.  You can 
read more about variables in 3.5.4 Using Variables in Notifications. 

IR conditions trigger programs when IR commands are received from a remote control.  
See 3.5 Variables for more information. 

Module conditions trigger programs based on option ISY modules, such as the Electricity 
meter module or the Climate module.  See 3.9 Optional Modules for more information.  

Elk conditions trigger programs based on the state of available Elk resources, assuming you 
have an Elk security system installed and communicating with your ISY, and have the 
optional Elk Security System module installed.  More information is available in the section 
titled 3.9 Optional Modules. 

3.3.6 Program Actions 

In the Add To Program button section, click ACTION to add an Action to your Program.   

Program Actions are commands that are run when the IF statement is true (a THEN action) 
or if the IF statement is no longer true (an ELSE action).  When adding an Action to your 
program, be sure to click the ADD TO THEN or ADD TO ELSE button depending on your 
intended result. 
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Insteon actions send INSTEON commands to devices or scenes to turn them ON, OFF, etc.  
Not all options available for all devices: 

ON (send a standard ON command) 

OFF (send a standard OFF command) 

FAST ON (turn device full on ignoring programmed on level or ramp rate) 

FAST OFF (turn device full off ignoring programmed ramp rate) 

FADE UP (start the ramp up of a dimmable device 

FADE DOWN (start the ramp down of a dimmable device) 

FADE TOP (stop the ramping up or down of a dimmable device) 

BRIGHT (small increase in brightness of a dimmable device) 

DIM (small decrease in brightness of a dimmable device) 

QUERY (query the current state of a device) 

BEEP DURATION (causes a supported device or scene to emit a beep) 

BACKLIGHT LEVEL (sets the backlight level on a supported device) 

Send X10 actions send X10 commands to X10-compatible devices.  Using this feature, ISY 
programs can control a wide range of X10-compatible devices. 

Notify actions sends an email or SMS text message to recipients.  Please see 3.6 The 
Integrated IR Receiver for more information. 

Program actions run or modify other ISY programs.  The following options are available: 

Run (If) (runs the IF portion of a program) 

Run Then (runs the THEN portion of a program) 

Run Else (runs the ELSE portion of a program) 

Stop (stops a currently running program) 

Enable (enables a disabled program) 
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Disable (disables and enabled program) 

Enable Run at Startup (sets a program to run at startup) 

Disable Run at Startup (sets a program to NOT run at startup) 

Wait actions create a pause in a running program.  For example, to turn your driveway 
lights off 5 minutes after your front door lights are turned off, you could do the following: 

 

Figure 48  WAIT Action 

If the RANDOM checkbox is checked, a random time between 0 and the specified time is 
used.  For example, this program would wait between 0 and 5 minutes: 

 

Figure 49  RANDOM Action 

Repeat actions will repeat an action or group of actions multiple times.  If the RANDOM 
button is checked, a random number of repeats between 0 and the specified value is used. 
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For example, to flash your driveway lights on and off 5 times, every 2 seconds, you could: 

 

Figure 50  Flash Lights ON and OFF 

Variable actions allow you to adjust the value of a defined variable within program.  For 
more information on Variables please see 3.5.4 Using Variables in Notifications. 

Adjust Scene actions adjust the On Levels and Ramp Rates of devices or scenes.  For 
example, use this function to adjust scenes so that they turn on at brighter levels during the 
day, and perhaps at dimmer levels during the evening.  Please keep in mind that many 
devices require a reboot before On Level or Ramp Rate changes take effect, so this function 
may not be useful in all cases. 

System actions are used to notify compatible clients of energy related alerts. 

Other Actions may be available depending on what optional modules you may have 
installed.  For more information, see 3.9 Optional Modules. 

3.3.7 Program Folders 

To create a new folder, simply click the NEW FOLDER button on the bottom-left corner of 
the screen.  You can also create new folders by right-clicking on the program hierarchy 
(left-hand side of the screen) and choosing New Folder. 

Folders can be used to store Programs to help organize them by type, category, etc.   

Folders can also have conditions set on them to aid in program functionality.  For example, 
you could create a Vacation Programs folder that contains only programs that should run 
when you are on vacation.  In the following example, the user turns a keypad button called 
“GarageControls2E” on if they are going away on vacation.  The folder is set with the 
following conditions so that the contained programs will run only if that vacation keypad 
button is on: 
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Figure 51  Folder Conditions 

To set conditions on a folder, simply click the folder to select it and adjust conditions as you 
would any ISY Program. 

3.3.8 Other Functions 

Status.  To quickly view the current status of a Program, simply right-click it and choose 
Status which brings you to the Program Summary tab with the selected program 
highlighted. 

Copy / Copy Tree.  To duplicate a program, simply right-click the Program and choose 
Copy.  This is especially useful if creating several similar Programs.  To duplicate a Folder 
and all contained Programs, right-click the Folder and choose Copy Tree. 

Import / Export.  Programs can be imported and exported to the ISY by right-clicking a 
Program or Folder and choosing the desired function. 

Find / Replace.  Right-click within your Program hierarchy to start a Fine / Replace.  This 
function allows you to search your programs for specific devices or text strings, and 
optionally replace the results.  

Copy To Clipboard.  To copy a specific Program as text to your clipboard, simply right-
click it and choose Copy To Clipboard.  The text can then be pasted into practically any 
Windows application, text editor, web browser, etc. 

Rename.  To rename a Program or Folder, simply right-click it and choose the  Rename 
function. 

Remove.  To remove a Program or Folder (and all contained Programs), simply right-click 
it and choose Remove.  Remember to hit the SAVE CHANGES button when complete. 
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3.4 The Programs \ Summary Tab 

The Programs \ Summary page displays a list of all your Programs, Folders, and 
information about each.  To open this tab, first click the Programs tab, then the Summary 
sub-tab.  Here are the columns of information available: 

Name (the Program or Folder’s name) 

Enabled (shows whether the Program is currently enabled or disabled) 

Run At Startup (shows whether the Program is set to run at startup) 

Activity (shows if the Program is currently running or is idle) 

Status (shows if the Program’s IF statements are currently true or false) 

Path (shows the Folder that the program is located in) 

Last Run Time (shows the last time the Program’s IF statements were evaluated) 

Last Finish Time (shows the last time the Program completed) 

Next Scheduled Run (shows the next time the Program is scheduled to run, if applicable) 

Each column can be sorted by clicking its column header. 

There is a toolbar on the top portion of the screen that you can use to interact with ISY 
programs in a variety of ways. 

 

Figure 52  ISY Toolbar 

To perform an action on a program, simply selecting it by clicking on it, click the left-most 
pull-down menu labeled “Choose” to select an action, and click the Apply button. 

Available actions are: 

Enable – enable a program that has been disabled 

Disable – disable a program so that it will not run 
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Run (If) – force the evaluation of the IF statement and run the program 

Run Then – force the run of the THEN portion of a program 

Run Else – force the run of the ELSE portion of a program 

Stop – stop a currently running program 

Enable Run At Startup – set a program so that it will automatically start running when the 
ISY reboots 

Disable Run At Startup – set a program so that it will not automatically run when the ISY 
reboots 

On the left-most side of the tool bar are the EDIT button which will bring you to the 
Program Details tab and allow you to edit the currently highlighted program.  The 
REFRESH button forces a refresh of the screen. 

3.5 Variables 

Variables can be incredibly useful when creating programs on the ISY.  Variables can be 
stored, modified using arithmetic operations, and compared.  You can use variables to 
provide information, trigger programs, etc. 

To view your variables, click on the Programs tab then the Variables sub-tab.   

There are two different types of variables (Integer and State), each divided into a separate 
sub-tab. The only difference between the two is that State variables create ISY events when 
modified, so they can be used to trigger ISY Programs. 

For example, if you’d like to create an ISY Program that runs only when a variable is or 
reaches a certain value, use a State variable.  Otherwise, if the variable’s value will not be 
used to trigger a program, feel free to use the simpler Integer variable. 

3.5.1 Creating Variables 

To create a new variable, click the Add button on the bottom of the screen.  Here is a list of 
each column and a quick definition: 

Name – This is the user-defined name of the variable.  Choose a name that’s descriptive so 
that you’ll be able to quickly identify the variable you want to use in ISY Programs. 

Init – This is the initial value of the variable, the value it has if the ISY is rebooted.  This can 
be defined here and also updated using ISY Programs so that a variable value can persist 
even if the ISY loses power. 
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Value – This is the current value of the variable.  Again, this can be defined here and also 
modified via arithmetic operations using ISY Programs. 

Last Changed – This displays the date and time that the variable was last modified. 

3.5.2 Using the Status of Variables in Programs 

You can use the If portion of an ISY Program to check the state of a variable.  To do those, 
choose Variable when defining your If statement, then choose your Variable, then choose 
what you’d like to check for.  

For example, you can check to see if a Variable is a certain value, if it’s NOT a certain value, 
if it’s greater than a certain value, etc.  You can also compare one variable to another. 

In this screenshot we are checking to see if a variable called Counter is greater than 3: 

 

Figure 53  Counter Variable 

3.5.3 Modifying Variables in Programs 

You can also use ISY Programs to modify variables.  You can perform standard arithmetic 
functions on a variable, change a variable to a specific value, or modify a variable’s Init 
state. 

The following functions can be performed on a variable: 

Command Function Performed 

= Sets the variable to a specified value. 

+= Adds to the variable 

-= Subtracts from the variable 

*= Multiples the variable 

/= Divides the variable 

%= Performs a remainder function on the variable 

&= Performs an AND (binary) function on the 
variable 

|= Performs an OR (binary) function on the 
variable 

=Random Sets the variable to a number between 1 and 
the specified number 

Init To Sets the variable’s initial value 
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For example, the following screenshot increases a variable by 1: 

 

Figure 54  Increment a Variable by 1 

This example sets the Init value of a variable to the current value of another variable: 

 

Figure 55  Set a Variable’s Initial Value 

3.5.4 Using Variables in Notifications 

Variables can also be useful when sending notifications.  Say you have a variable that you 
use to count the number of times a motion sensor is trigged overnight.  You could send 
yourself an email in the morning telling you how many times it was triggered. 

Your notification might look like this: 

 

Figure 56  Email Based on Motion Sensor Trigger 



 -  45  - 

3.6 The Integrated IR Receiver 

If your ISY came equipped with an integrated IR receiver (model numbers that contain 
“/IR”), Programs can be triggered using an RC5-compatible remote control.  To program IR 
codes into the ISY, click the Configuration tab, then the IR sub-tab.   

The IR configuration page lists all IR codes currently recognized by the ISY.  The first 
column titled “Name” allows you to customize the name of a stored IR code.  Simply double-
click the IR code you’d like to change, and type the desired name.  This is how the IR code 
will be listed under ISY Program Conditions. 

The “IR Code” is an internal number used to identify the IR code.  It cannot be change and 
for the most part should be ignored. 

The “Status” column contains the last Condition received from a particular IR code.  The 
following conditions are available: 

Pressed – indicates the remote control button was pressed and released normally. 

Double-Pressed – indicates the remote control button was pressed twice quickly (similar 
to a mouse double-click). 

Held – indicates the remote control button was pressed and held (not yet released). 

Released – indicates the remote control button was pressed and held, then released. 

The above Conditions are available in ISY Programs, allowing you to control your home in a 
wide variety of ways from a simple remote control. 

There are also 3 buttons on the bottom of the IR Configuration Page: 

Save – this button saves the currently displayed IR codes to the ISY. 

Reload – this button aborts any IR codes learned since the last Save, and “reloads” the last 
saved IR database from the ISY. 

Restore Defaults – this button restores the ISY to its default, blank IR database. 

3.6.1 Using the 40 Default IR Codes 

The ISY is able to download 40 pre-configured IR codes.  These 40 pre-configured codes 
make it easier to configure remote controls that contain the ISY in their database (such as 
the Logitech Harmony), or remote controls that can import CCF files.   
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To import these 40 pre-configured IR codes into your ISY, simply click the “Import Default 
IR Codes” button at the top of the screen.  This will auto-populate the IR Configuration page 
with 40 codes labeled “IR_001, IR_002, etc.”  This will overwrite any IR codes you may 
already have stored on your ISY.   

With Logitech Harmony remote controls, you can simply choose the Universal Devices ISY 
from the Harmony software’s built-in database.  The Harmony software will allow you to 
drag and drop the ISY’s 40 default IR codes onto buttons on your remote control.   

If you’re using a Pronto or other CCF-compatible remote control, we have a CCF file 
available for download here: 

http://www.universal-devices.com/ir/99/isy-99.ccf 

If you’re using a Universal Remote Control (URC) brand remote, we have a MXJ file 
available for download here: 

http://www.universal-devices.com/ir/99/isy-99.mxj 

Once your remote control is configured, create Programs to have your ISY perform actions 
or a series of actions based on your remote’s button press.  IR codes stored on the ISY will 
be available as Conditions when creating ISY Programs. 

3.6.2 Using the IR Learning Mode 

If more than 40 IR codes are needed, or if you prefer to “teach” your own IR codes, the ISY 
features a learning mode that is capable of reading most codes sent from RC5 compatible 
remote controls.  For best results, try using codes compatible with Philips-brand devices, 
which are typically RC-5 compatible. 

To use the ISY’s learning mode, hit the button titled “Enter Learning Mode”.  The ISY will 
now wait for IR codes, and once received they will be entered into the ISY’s IR database.  
Simply point your remote control at the front of the ISY and press the button you’d like the 
ISY to learn. 

If a button press is not recognized, or a button is not recognized as expected, please try a 
different button/code. 

Some symptoms of an incompatible IR code are: 

Multiple entries created from a single button press 

Inaccurate Status values (eg. you PRESS a button but the ISY shows it as HELD) 

http://www.universal-devices.com/ir/99/isy-99.ccf
http://www.universal-devices.com/ir/99/isy-99.mxj
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We highly recommend testing an IR code well to ensure it is 100% reliable with the ISY 
before saving.  Make sure the ISY consistently displays the code correctly when the button 
is Pressed, Held, Released, etc. 

When done teaching IR codes to your ISY, hit the “Leave Learning Mode” button on the top 
of the screen and be sure to “Save” your changes.  If you wish to revert to the last saved IR 
codes stored on your ISY, hit the “Reload” button located on the bottom of your screen. 

3.7 Notifications 

Using Programs, you can configure the ISY to send you notifications via text message or 
email.  For example, the ISY could notify you if your thermostat drops below or above a 
pre-defined temperature, when motion is detected in an area of your home, or when your 
garage door opens unexpectedly. 

3.7.1 Adding Recipients & Changing Server Settings 

To configure recipients of these notifications, click on the Administrative Console’s 
Configuration tab, choose the Emails/Notifications sub-tab, then the Settings/Groups tap 
below that. 

On the bottom portion of the screen, labeled Groups, hit the Add button to create a Group 
and add recipient information.  Simply name your group, then hit the field under the 
Recipient column to edit the recipients.  A group can contain one or more recipients that 
you would like to notify. 
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Figure 57  Email Recipients Screen 

Choose the type of recipient you’d like to add (Regular Email, text notification, etc.), hit the 
Add button, then type the recipients corresponding address as instructed.  When done, hit 
OK to finish editing the group.   

Always remember to hit the Save button on the bottom of the Admin Console to save 
your settings to the ISY. 

To send a test message to one of your recipient groups, highlight the group and hit the Test 
button on the bottom of your screen. 

On the top of the screen you’ll also find the “SMTP Settings” window where you can specify 
the email server used to deliver notifications.  If “Use Default” is checked, the ISY will utilize 
the Universal-Devices server to send out notifications. 

For advanced users, or if your ISP is blocking access to outside email servers, you can 
uncheck this box and specify a custom SMTP server to use. 

3.7.2 Custom Notifications  

To configure custom notifications, click the Customizations sub-tab and hit the Add button.  
Simply name your customization and type the message click the Customized Content field 
to edit the content you want to send with your notification. 
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Use the drop-down boxes to add real time information to your notification, such as current 
time/date, variable values, security system information, weather conditions, etc. 

Once created, these custom notifications can be triggered and sent using your ISY 
Programs. 

Note that Custom Notifications supports plain text, HTML and XML. 

For example, you could set up a variable used to count how many times your motion sensor 
triggered every night.  In the morning, the ISY could email this information using the 
following notification: 

 

Figure 58  Motion Sensor Email 

This program would send this notification to you every morning at 6am, then reset the 
variable back to 0: 

 

Figure 59  Scheduling an Email 
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Here is a link to a page on the ISY wiki that details the available Email Substitution 
Variables: 

http://wiki.universal-devices.com/index.php?title=ISY-
99i_Series_INSTEON:Custom_Email_Substitution_Variables  

3.8 Interfacing with the Elk 

If you have an Elk M1 alarm/automation panel installed, it can be configured to 
communicate with the ISY.  Once communication is established, you can: 

Arm/Disarm your Elk from the ISY’s web interface and Administrative Console 

Control Devices and Scenes stored on the ISY from your Elk (through Elk keypads, 
programs stored on the Elk, etc.) 

On the Elk side, you will need an Elk M1XEP  which provides an Ethernet-interface for your 
Elk.  We highly recommend configuring your Elk with a static IP address (see your Elk 
documentation for instructions).  Using Elk’s ElkRP software, ensure that you enable the 
Elk’s “Non-Secure” port in the M1XEP setup. 

In the ISY’s Administrative Console, click the Configuration tab, then the Elk sub-tab, then 
the Configuration sub-tab.  This is where you can configure your Elk: 

 

Figure 60  ELK Configuration Screen 

Type your Elk’s IP address in the appropriate field, and enter your Elk’s Non-Secure Port 
(default is 2101).  Then enter your Elk’s security code, and hit the SAVE button to save your 
settings and initiate communications. 

http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Custom_Email_Substitution_Variables
http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Custom_Email_Substitution_Variables
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If successful, a “Security System” bar will appear on the top of your Administrative Console 
showing you the current state of your Elk and allowing you to type your Elk’s security code 
and arm/disarm it: 

 

Figure 61  ELK Status Screen 

To allow control of your ISY-configured Devices and Scenes from the Elk, you must export 
your lighting information from the Administrative Console and import this file onto your 
Elk using ElkRP.  Hit the Export sub-tab to go to the Export screen.   

The right-hand column will list all Devices and Scenes available for export to the Elk.  
Simply highlight your desired nodes and hit the <<Add To Export List button to add your 
selected items to the list.   

When done, hit Save, then the Export button.  This will create an XML file containing your 
ISY’s information and display it in your default web browser.  Save this to your PC as an 
XML file and import this saved file into your Elk.  Using ElkRP: 

Open the Automation folder 

Right-click the Lighting icon and choose “Import Lighting Data” 
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Figure 62  Import Lighting Data 

Follow the on-screen instructions to finish importing the ISY’s information into your Elk. 

Enhanced Elk-integration capabilities are available when using the optional Elk 
Security System module.  See 3.9.5 ELK Security Module for more information. 

3.9 Optional Modules 

Universal-Devices offers a variety of optional modules that enhance the capabilities of your 
ISY in a variety of ways.   

To purchase a module, click the HELP pull-down menu in the ISY’s Administrative Console, 
choose the “Purchase Modules” option, and follow the on-screen instructions. 

3.9.1 Network Module 

The ISY’s Network Module enhances the ISY with several key features: 

Web Server – using the Network Module, the ISY can be used as a web server to server up 
your own applications, pictures and files. 
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Network Resources – with the Network Module, the ISY allows you to call any network 
resource (TCP, UDP, HTTP, HTTPS) using ISY Programs.  You can also control serial devices 
using Ethernet to RS-232 adapters. 

Wake On LAN – this feature allows you to turn on PCs and other compatible network 
devices using their Wake On LAN feature. 

Web Server 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Web Server tab to copy files and folders to your ISY’s internal 
web server. 

The left side of the screen will allow you to browse your local PC's files and folders.  The 
right side of the screen displays the file/folder structure within your ISY.  Simply drag-and-
drop files and folders from the left side of the screen to your ISY’s /USER/WEB folder on 
the right-side of your screen. 

Right-click a file or folder stored on your ISY to rename, remove, or set it as your ISY Web 
Interface’s default page.  To restore the ISY Web Interface to its default home page, click the 
“Use Default” button on the bottom of the screen. 

Network Resources 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Network Resources tab to configure your resources. 
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Once devices have been added, they will be available in ISY Programs as Actions under the 
Networking category: 

 

Figure 63  Networking Actions 

More information on known-compatible 3rd party devices and how to control them is 
available in this Wiki article: 

http://wiki.universal-devices.com/index.php?title=ISY-
99i_Series_INSTEON:Networking:Network_Resources 

Wake On LAN 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Wake On LAN tab to configure. 

Once Wake On LAN devices have been added to your ISY, they will be available in ISY 
Programs as Actions under the Networking category. 

http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Networking:Network_Resources
http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Networking:Network_Resources
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3.9.2 Climate Module 

Using the Climate Module, you can create ISY Programs using local weather information as 
conditions.  This module gathers information from WeatherBug, which provides a huge 
number of weather stations to pull data from. 

To view and configure your Climate Module, click the Configuration tab in the ISY’s 
Administrative Console then the Climate sub-tab.  To choose your local weather station, 
click the FIND button and type your local zip code.  Double-click your Area to see a list of 
weather stations within your area.   

   

Figure 64  Weather Stations 

Double-click a station to utilize it with your ISY.  For best results, choose a station as close  
to your location as possible. 

Once selected, choose how you would like the information displayed (English or Metric).  
Also feel free to adjust the Polling Interface, which is how often your ISY connects to 
WeatherBug for updated weather information.  Hit the SAVE button to save your 
configuration. 
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You should now see local weather information as shown below: 

 

Figure 65  Local Weather Information 



 -  57  - 

Now that your Climate Module has been configured, you can use this information as 
Conditions in ISY Programs.  When choosing a condition, choose Module and Climate to see 
all available conditions: 

 

Figure 66  Using Climate Conditions 

3.9.3 Electricity Module 

This module is available ONLY with the ISY-994i Series.   

Brultech Electricity Meters can be utilized to monitor electricity consumption.  This 
information can be used as conditions within ISY Programs. 

To configure the ISY to pull information from your Brultech meter, click the Configuration 
tab in the ISY’s Administrative Console and choose the Electricity sub-tab.  Check the 
“Enabled” box, enter your Brultech meter’s URL, and choose the preferred polling interval 
in seconds.  Hit SAVE to save your settings to the ISY. 

 

Figure 67  Electricity Meter Settings Screen 
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Once your Brultech meter is configured, you can use this information as Conditions in ISY 
Programs.  When choosing a condition, choose Module and Electricity to see all available 
conditions: 

 

Figure 68  Electricity Conditions 

NOTE:  Check out our ISY-994iZ Series device which contains Zigbee support for 
communicating with the Brultech Electricity Meters (and more!)  

3.9.4 Open Auto Demand / Response Module 

Please peruse OpenADR Quick Setup Guide: http://www.universal-
devices.com/docs/production/OpenADR Quick Setup Guide.pdf  

3.9.5 ELK Security Module 

While the ISY does include some ELK integration built-in, it is fairly limited in that most of 
the integration must come from the ELK side.  For example, you can write a program on the 
ELK to turn a light on through the ISY, but you cannot write an ISY program that turns a 
light on based on the state of an ELK resource. 

The ELK Security Module changes that, fully integrating the ELK with the ISY allowing you 
to use the ELK’s available resources in your ISY programs. 

The list and state of available ELK resources can be found in the main ELK tab in the Admin 
Console.   

 

Figure 69  ELK Resources 

Within this tab you can choose sub-tabs to view ELK resources such as Zones (typically 
motion sensors, door sensors, window sensors, etc.).  You can view Outputs configured on 
the ELK, and also any thermostats. 

http://www.universal-devices.com/docs/production/OpenADR%20Quick%20Setup%20Guide.pdf
http://www.universal-devices.com/docs/production/OpenADR%20Quick%20Setup%20Guide.pdf
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Using your ELK resources in ISY Programs is a snap.  For example, you could trigger an ISY 
Program if a garage door sensor tied to your ELK was open: 

 

Figure 70  Using ELK Conditions 

You could also use an ISY Program to arm your ELK security system: 

 

Figure 71  ELK Actions 

3.9.6 X10 Module 

This optional module provides cleaner management and better control over A10/X10 
devices, allowing you to add them to the Admin Console’s device tree just like INSTEON 
devices. 

Please note the following limitations: 

This module uses simulated INSTEON addresses internally. Though unlikely, it could 
potentially conflict with existing INSTEON devices in your ISY, stopping you from using 
those particular INSTEON modules. 

This module only allows for ON/OFF commands in the device tree. No support for 
bright/dim. 

Note that X10 devices cannot be added to INSTEON Scenes. 

To add an A10/X10 device to your tree, click the Link Management pull-down menu and 
choose New INSTEON/A10/X10 Device. 
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Type the A10/X10 device’s address, name the device, then choose the appropriate device 
type: 

 

Figure 72  Adding and X10 Device 

Once added, the A10/X10 device will be shown in your Admin Console’s device tree and 
can be organized or used in ISY Programs just like any other INSTEON device. 

3.9.7 The Irrigation Module 

This module is designed to calculate the amount of water that is lost from the soil and 
plants and replace it with a close approximation of what was lost. Today in a world of 
"Green is good" every consumable resource such as water can be better conserved with 
such a tool. 

The module takes the local WeatherBug data, the user settings, and calculates each day the 
average water that has been lost. The user then can have programs that respond to these 
calculations and apply the appropriate amount of water to replace that loss. When those 
programs complete they trigger a command that lets the module know that the water has 
been applied and can be subtracted from the module's tally. Each day this is done 
completing the cycle of tracking the data and applying the water. During cooler times of the 
year the watering days frequency will slow down, and during the warmer parts of the year 
the watering frequency will ramp up to daily. 
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Figure 73  WeatherBug Settings 

For more information, please see the article on our Wiki located here: 

http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-
26_INSTEON:Using_the_WeatherBug_Irrigation_Module 

3.10 Diagnostics 

The ISY includes a handful of built-in tools to help troubleshoot problems that might occur, 
such as Programs that do not behave as expected or communication issues to or from 
INSTEON devices. 

3.10.1 The Event Viewer 

The Administrative Console’s Event Viewer can be an invaluable tool in helping to diagnose 
problems you might be having.  To access the Event Viewer, click on the Tools pull-down 
menu, then Diagnostics, then Event Viewer. 

The Event Viewer window displays information on what is happening on your ISY, such as 
commands sent to devices, information received from devices, programs that are executing, 
and much more.   

There are several levels of detail available using the Change Level button (level 3 being the 
most detailed).  Use the “Save Log To” button to save the current Event Viewer output to a 
text file. 

http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Using_the_WeatherBug_Irrigation_Module
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Using_the_WeatherBug_Irrigation_Module
http://www.universal-devices.com/mwiki/images/9/9e/WeatherBug_Irrigation_Module_Settings.png
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3.10.2 System Status 

The System Status screen shows you basic information about the ISY, such as the date and 
time it was last started, the size of the installed SD card, and how much free space is 
available. 

The access the System Status screen click on the Tools pull-down menu, then Diagnostics, 
then System Status. 

3.10.3 PLM Info/Status 

This screen will tell you if the ISY is communicating with an attached PLM, and also display 
the INSTEON address and firmware version of an attached PLM. 

To view this information click on the Tools pull-down menu, then Diagnostics, then PLM 
Info/Status. 

3.10.4 PLM Links Table 

To see the link table in your attached PLM click the Tools pull-down menu, then 
Diagnostics, then PLM Links Table.  Hitting Start will begin reading the link table from your 
attached PLM.   

Once complete, you can hit the Count button to see the total # of links read from your PLM.  
This can be useful as PLMs have limits to how many links they can store.  Unfortunately this 
limit does vary depending on which version PLM you have. 

There is a Stop button available on this screen which, if pressed, will abort the reading of 
your PLM’s links table.  There are also Save and Load buttons available to export or import 
the links table to an XML file. 

3.10.5 Show Device Links Table 

To view the links table of an INSTEON Device, click the Tools pull-down menu, then 
Diagnostics, then Show Device Links Table.  Choose your device, adjust the starting and 
ending addresses (only if needed) and hit Ok.  This will start reading the selected Device’s 
links table. 

Once complete, you can hit the Count button to view your Device’s total link count.  This 
can be useful as Devices do have limits to how many links they can store.  Unfortunately the 
limits do vary depending on the device. 

You can also hit the Compare button to compare the links read in from the Device to the list 
of links the ISY believes the Device should have.  If there is a discrepancy, you may want to 
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run a Restore on the device to correct the links table.  For more information on the Restore 
function, see 3.2.6 Other Functions (Restore, Disable, Query, & more). 

There is a Stop button available on this screen which, if pressed, will abort the reading of 
your Device’s links table.  There are also Save and Load buttons available to export or 
import the links table to an XML file. 

3.10.6 Show ISY Links Table 

To view the list of links that the ISY believes a device should have, click the Tools pull-down 
menu, then Diagnostics, then Show Device Links Table.  Choose your device and hit OK and 
the links table will be displayed. 

You can hit the Count button to view your Device’s total link count.  This can be useful as 
Devices do have limits to how many links they can store.  Unfortunately the limits do vary 
depending on the device. 

There are also Save and Load buttons available to export or import the links table to an 
XML file. 

3.10.7 Scene Test 

The Scene test function can be very helpful in troubleshooting INSTEON communication 
issues.  To open this tool, click the Tools pull-down menu, then Diagnostics, then Scene 
Test.  Choose the Scene you would like to test then hit OK. 

The Event Viewer will pop up and an ON and OFF command will be sent to the specified 
scene.  The results of the test will be displayed in the Event Viewer window, indicating 
whether the test succeeded or failed for each member of the scene. 

3.10.8 Query INSTEON Engine 

If a device is not behaving as expected, for example of On Level or Ramp Rate functionality 
is not working properly, the ISY may not have proper information about the device’s 
capabilities.  To refresh this information simply right-click the Device in the node list and 
choose Query INSTEON Engine. 

This will update the ISY’s stored information and may correct the issue you are having.   

4 Glossary 

Controller:  A device that not only responds to commands issued to a scene, it also controls 
the scene.  An example of a Controller might be a button located on a Keypad – 
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when that Keypad button is pressed, all members of the scene will respond as 
programmed.  Controllers are colored red within a scene. 

Cross-Linking:  A configuration where two items control the same device.  For example, 
you might have two switches in your kitchen that you’d like to control your 
kitchen table light.  One switch is physically attached to the kitchen table light, 
but you’d like the other switch to control it as well.  In this case you would add 
each device to a Scene as a Controller (shown in red).   

Device Group:  An INSTEON device that creates multiple entries within the ISY.  For 
example, a KeypadLinc can have 6 or 8 nodes in the ISY (one for each button).  
You can choose to group these nodes together in a scene by right-clicking the 
primary node and choosing “Group Devices.” 

INSTEON:  An integrated network protocol that combines wireless radio frequency (RF) 
with the home's existing electrical wiring.   This dual-mesh network approach 
means INSTEON is faster and more reliable than X10.  INSTEON is a peer-to-peer 
network.  Its devices do not require network supervision and for 
straightforward applications an INSTEON network can operate effectively 
without a central controller. 

Each INSTEON device has a unique factory-assigned address.  Like X10, each 
INSTEON device constantly listens for any command broadcast by other 
INSTEON devices, but unlike X10, each INSTEON device broadcasts each 
command it generates and can re-broadcast each command it receives.  

When an INSTEON device is broadcasting a command it is acting as a Controller; 
when responding to a command received from an INSTEON device it is acting as 
a Responder. 

Each INSTEON device can be “taught” to respond to commands issued by any 
INSTEON device in that network.  INSTEON devices can be taught to respond 
collectively and thereby create Scenes.  In a Scene, one from a number of 
INSTEON devices can broadcast a signal that causes one or several INSTEON 
devices (possibly including itself) to turn on or off or to change state in some 
more subtle way. 

INSTEON scenes offer practical solutions to many domestic lighting problems: 
tap one key and so set each of the lights in the family room to that state for 
which the home theatre is most effective, tap another to ensure all basement 
lights are switched off once at the top of the stairs, or a third to ensure the 
staircase and upstairs landing lights are both on before a guest is dispatched to 
find the upstairs bathroom.  
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INSTEON scenes are easy to set up initially but as more scenes are added 
changing and maintaining them can become burdensome.  While leaving existing 
scenes unchanged, ISY can discover them and bring them under the control of 
the ISY.  There they can be easily managed, enhanced and coordinated with 
other scenes and X10 devices. 

Infrared (IR):  Relating to the invisible part of the electromagnetic spectrum with 
wavelengths longer than those of visible red light but shorter than those of 
microwaves. 

On Level:  The brightness level at which a device is turned on when pressed (25%, 75%, 
etc.).   

PowerLinc Modem (PLM):  A family of products sold by Smarthome.  It consists of the 
2412S (now discontinued) and the 2413S which are sold separately.  The PLM is 
required to interface with INSTEON devices. 

Program:   

Ramp Rate:  The speed at which a device is turned on when activated.  For example, a slow 
Ramp Rate will cause a light to turn on slowly when a button is pressed. 

Responder:  A device contained within scenes that only responds to commands issued to 
the scene.  For example, a lamp module with a table lamp attached would likely 
be a Responder to the scene.  When the scene is turned on, the lamp module 
might turn on.  When the scene is turned off, the lamp module might turn off.  
Responders are colored blue within a scene. 

Scene:  A collection of INSTEON devices that react to and with one another in various ways.  
Scenes are comprised of both Responders and Controllers. 

Schedule:   

Universal Plug and Play (UPnP):  A set of standards intended primarily for residential 

networks to enable users to link their local and remote personal computers, printers, 

Internet gateways, Wi-Fi access points and mobile devices to seamlessly discover 

each other's presence on the network and establish functional network services for 

data sharing, communications, and entertainment. 

X10:  A protocol for communication among electronic devices used for home automation.  
Developed in 1975, X10 was the first general purpose network technology to 
allow remote control of home devices and appliances for residences.  With new 
components still available and millions of units in use worldwide, it remains 
today’s most widely deployed home automation protocol. 

https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Network_service
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X10 primarily uses power line wiring for signaling and control.   Each X10 switch 
has a user-assigned address.  The way X10 addresses are applied to switches 
depends on type and manufacturer.  X10 switches operate by responding to the 
physical control (switch) on the device itself or by responding to a X10 control 
signal addressed to that switch from an X10 signal source elsewhere in the 
residence’s electrical system.   

Typically, X10 devices are either controllers that generate X10 signals or light 
switches or electrical sockets that respond to X10 signals.  Controllers that are 
only capable of generating X10 signals tend to have a somewhat utilitarian 
appearance, so X10 signals are now often generated by Dual-Band devices such 
as the KeypadLink controller, by a PDA via an IR/X10 protocol converter, or 
better yet, by a program in the ISY. 

Although, as a protocol, X10 lacks the capabilities and operational reliability of 
INSTEON, X10 switches remain the preferred way to control devices that may 
create surges at power on such as traditional fluorescent lights and general 
purpose electrical sockets. 

5 Index 
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Appendix A:  Front and Rear Panel LEDs 

Front Panel LEDs:  Understanding the ISY’s front panel (see below) LEDs can be helpful 
when troubleshooting problems.   

 

Figure 74  ISY Front Panel 

Here is a table that helps explain each LED and LED combinations: 

LED or Combination Indicated Status 
Power on steady The PWR LED indicates that the ISY has power, either through the 

PLM or via a separate AC adapter.  If the PWR LED is not lit, the ISY 
does not have power. 

RX, TX and Memory off If all three of these LEDs are off, the ISY is idle. 

RX blinking The RX LED blinks when the ISY is receiving INSTEON traffic.  

TX blinking The TX LED blinks when the ISY is sending INSTEON traffic. 

Memory blinking The MEM LED blinks when the ISY is accessing its internal memory. 

RX on steady If the RX LED is on steady, the ISY is having a problem 
communicating with the PLM.  Unplug the PLM for 10 seconds, 
then plug it back in to reboot.  If the problem continues, either the 
PLM or cable is most likely defective. 

Error blinking A blinking ERR LED indicates a file system error.  Please power off 
the ISY and try to re-seat the SD card.  If that does not help, the SD 
card may be defective.  Please see Appendix C:  Replacing / Upgrading 

Your SD Card 
Memory and Error 
blinking 

If both the MEM and ERR LEDs are blinking, the ISY is unable to 
communicate with your Ethernet network.  Please check all cable 
connections, try rebooting your router or switch, and ensure that 
you have a DHCP server available. 
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Rear Panel LEDs:  There are also 2 LEDs on the rear of the ISY where the Ethernet cable 
attaches.  One LED indicates a good network connection (should be on solid) while the 
other should flash with network activity. 
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Appendix B:  Factory Reset 

There are only a few reasons why you might want to factory reset your ISY.  In most cases, 
a factory reset will not help any problems you might be having. 

Please be sure to thoroughly investigate your problem before trying a factory reset.  If 
possible, be sure to have a known good backup of your ISY’s configuration before factory 
resetting. 

NOTE:  A factory reset of the ISY will not erase any programming stored on INSTEON 
devices. 

To factory reset your ISY: 

 Use a sharp object (for example an straightened paperclip) to push in the recessed 
Reset button and watch for the RX, TX, MEM, and ERR LEDs to start flashing (once per 
second). 

 Hold the Reset button for approximately 10 seconds more, until the above LEDs turn off 
and the MEM LED flashes quickly. 

Release the Reset button and wait for the ISY to reboot (when the MEM LED stops flashing). 
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Appendix C:  Replacing / Upgrading Your SD Card 

In some instances you may want to upgrade or replace your SD card.  For example: 

 You have purchased the ISY’s Networking Module and need more storage for the 
internal web server. 

 You are experiencing a blinking ERR light which could indicated a bad SD card. 

The ISY supports up to a 16GB SD card. 

Once your SD card is replaced, you will need to re-load the firmware onto your ISY as well 
as restore your configuration from a backup.  Please be sure to have a good backup before 
attempting an SD card upgrade. 

Newer ISYs 

Newer ISYs have an externally accessible SD card.  Simply unplug all cables from your ISY, 
pull out the old SD card, and insert the new SD card.  You will also need to reload the 
firmware onto your ISY.  Proceed to the paragraph labeled “Reloading The ISY Firmware 
and Restoring From Backup.” 

Older ISYs 

Older ISY’s have internal SD cards, so the unit must be taken apart for the SD card to be 
replaced.  Please proceed with caution, and only if you feel comfortable taking apart your 
ISY. 

There are 4 screws holding on the cover to the ISY.  Remove those screws, and simply slide 
the cover off.  Once off you will see 4 screws holding the ISY’s circuit board to the bottom of 
the ISY’s case.  Simply unscrew all four screws, remove the ISY’s circuit board with caution, 
and replace the SD card. 
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Figure 75  ISY with Cover Removed 

Once you screw the ISY back together, you will need to reload the firmware.  Proceed to 
the paragraph labeled “Reloading The ISY Firmware and Restoring From Backup”. 

Reloading the ISY Firmware and Restoring From Backup 

Once you’ve replaced your ISY’s SD card, you will need to re-load the firmware as well as 
restore your configuration from a backup. 

 Boot your ISY with the new SD card installed 

 From a PC on your LAN, visit the following URL to launch the Administrative Console 
and locate your ISY:  http://www.universal-devices.com/99i 

 Login to the Administrative Console (default username and password are both “admin”) 

 Click on the HELP pull-down menu, then MANUALLY UPGRADE MY LIGHTING. 

 Browse to the firmware file you wish to install.  If you do not have a copy of the ISY 
firmware, please visit our forum for the download link:  http://forum.universal-
devices.com/viewforum.php?f=25 

http://www.universal-devices.com/99i
http://forum.universal-devices.com/viewforum.php?f=25
http://forum.universal-devices.com/viewforum.php?f=25
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 After the firmware is installed your ISY will reboot.  Please re-launch the Administrative 
Console and login:  http://www.universal-devices.com/99i 

 Click on the FILE pull-down menu, then RESTORE ISY and choose your last backup. 

http://www.universal-devices.com/99i
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Appendix D:  Upgrading Your Firmware 

The ISY’s Administrative Console checks for latest release firmware automatically.  When a 
new release is detected, you will be notified and given on-screen instructions on 
performing the update. 

In some cases, however, you may want to manually download and install a newer 
firmware.  Some beta firmware releases may contain important features or device support 
that you may want to utilize.  The Administrative Console will NOT notify you of beta 
firmware releases. 

To manually download and install a firmware release, please see the following forum 
where both final and beta releases are regularly posted along with specific upgrade 
instructions:  http://forum.universal-devices.com/viewforum.php?f=25 

In general, please note the following before performing a firmware update: 

 The downloaded firmware MUST remain zipped.  DO NOT unzip the downloaded file. 

 Please ensure you have a good backup before attempting a firmware update. 

 Disable all anti-virus and firewall software before attempting a firmware update. 

 Be sure to run firmware updates from a stable and, if possible, hardwired network 
connection.  Avoid running firmware upgrades from marginal wifi connections or off-
site locations if possible. 

 Once downloaded, click the HELP pull-down menu, then MANUALLY UPGRADE MY 
LIGHTING, and browse to the firmware file you have downloaded. 

 After upgrading your firmware, please close all browser windows and clear your Java 
cache as outlined in this article:  http://wiki.universal-devices.com/index.php?title=ISY-
99i/ISY-26_INSTEON:Clearing_Your_Java_Cache  

http://forum.universal-devices.com/viewforum.php?f=25
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Clearing_Your_Java_Cache
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Clearing_Your_Java_Cache
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Appendix E:  Assigning a Static IP Address to the ISY 

If you wish to assign a static IP address to your ISY, please open the Configuration tab, then 
the System sub-tab.  Uncheck the “Automatic (DHCP)” box and fill out the fields in the 
Network Settings section: 

 

Figure 76  Assigning a Static IP Address 

To avoid IP address conflicts, be sure to choose an address outside of the DHCP range set 
on your router.  Also be sure to type the correct Gateway and DNS addresses (typically 
your router IP address), otherwise the ISY will not have access to the internet. 

You can also configure custom HTTP and HTTPS ports on this screen. 

If you check the “Automatic (DHCP)” option, the ISY will not use a static IP address but 
instead get an IP address automatically from a DHCP server on your network. 
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Appendix F:  INSTEON Device Notes 

Some INSTEON devices require special care when used with the ISY.  Some need to be 
added to the system in a specific way, and some have unique options available when 
configuring with the ISY.  This section details some of this information and more.   

As always, please refer to the manufacturer’s documentation first.  Please consider the 
following notes as a secondary source of information. 

The following notes are sorted alphabetically by device name. 

ApplianceLinc 

Current ApplianceLincs will not act as Controllers – they will not notify the ISY or control 
other linked devices if turned on or off locally (via the SET button or using load sensing).   

EZI/O Devices (SimpleHomeNet) 

Due to variations in firmware on SimpleHomeNet devices, some units (especially older 
firmware) may not work well with the ISY.  Symptoms include the ISY not being notified of 
sensor state changes. 

If you’re having an issue with the ISY receiving status updates from an EZIO device, try the 
following steps: 

 remove the device from the ISY 
 factory reset the device 
 add the device back to the ISY by using “New INSTEON Device” and typing in the 

address 

I/OLinc 

Several options are available when configuring an I/OLinc on the ISY.  These include: 

 Timeout (seconds) - Sets the length of time the relay will close when Momentary is 
selected. 

 Program Lock - Disables Set Button programming. 
 Relay Follows Input - Sets Relay On when Sensor is On and Off when sensor if Off. 
 Send X10 Send On (or Off) - Send X10 when the sensor changes. 
 Trigger Off - If the TrigOff bit is set, Close Switch sends an OFF and Open Switch sends 

an ON. If the TrigOff bit is clear, Close Switch sends an ON and Open Switch sends an 
OFF.  

 LED on TX - The LED will flash when the device sends Insteon commands.  
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 Momentary: A - The relay will close momentary. If it is Linked while On it will respond 
to On. If it is Linked while Off it will respond to Off.  

 Momentary: Look at Sensor - If the sensor is On the relay will close momentarily when 
an On command is received. If the sensor is Off the relay will close momentarily when 
an Off command is received.  

 Momentary: Both - On and Off both cause the relay to close momentary.  

KeypadLinc 

KeypadLincs show up as multiple nodes on the ISY (6 button or 8 button, depending on 
which model KeypadLinc).  When switching between 6 and 8 button modes on the 
KeypadLinc, the device must be removed and re-added to the ISY. 

Only the KeypadLinc’s primary load button can be controlled directly by the ISY (through 
the Admin Console and ISY Programs).  To control secondary buttons, create a Scene 
containing the button and control the scene. 

KeypadLincs support several unique options, such as: 

 Manually Exclusive Buttons – groupings of buttons so that one and only one button in 
the group can be ON at any one time. 

 Toggle Mode – toggle a button to always stay ON or OFF (and only send the respective 
command when pressed) 

 LED Brightness – adjust the KeypadLinc button LED brightness 

Due to variations in KeypadLinc firmware, some configuration options may or may not be 
available. 

LampLinc 

Most LampLincs will not act as Controllers – they will not notify the ISY or control other 
linked devices if turned on or off locally (via the SET button or using load sensing).  
LampLincs labeled v4.2 or higher (firmware v33+) should act as Controllers. 

Motion Sensor 

Motion Sensors are RF devices, thus require the installation of an INSTEON RF receiver 
(such as an INSTEON AccessPoint).   

The Motion Sensor cannot be linked using Auto Discover.  To link a Motion Sensor to the 
ISY, please choose the LINK MANAGEMENT pulldown, then NEW INSTEON DEVICE.  Enter 
the device address manually (found inside the battery compartment), then select the 
“2420M INSTEON Motion Sensor” from the Device Type list. 
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Since the Motion Sensor is a battery-saving RF device, you must put the device into linking 
mode to add it to the ISY (and make any changes to the device, such as adding/removing 
from scenes).  Please follow the on-screen instructions to put the Motion Sensor into 
linking mode when prompted (hold SET button for 5 seconds). 

Once added to the ISY, the Motion Sensor will show up as 3 nodes.  The primary node is the 
motion sensing portion of the device, which updates according to sensed motion (or lack of 
motion).   

There is also a DUSK/DAWN node that will show ON when the device senses darkness and 
show OFF when the device senses light.  The Motion Sensor will not update this node until 
approximately 3.5 minutes after a state change has persisted. 

Finally, a Low Battery node will show as ON when the Motion Sensor senses a low battery 
condition and notifies the ISY. 

Motion Sensors support several unique options, such as: 

 Timeout (minutes) - Defines the period of inactivity before the Motion Sensor will send 
an Off. Default = 1 minute. Range = 0.5 - 8.5 minutes in 30 second increments.  

 LED Brightness - Default = 100. Range is 0 - 255.  
 Darkness Sensitivity - The higher the value, the darker it needs to be for the unit to see 

night. Default = 35. Range = 0 - 255. 

RemoteLinc 

RemoteLincs are RF devices, thus require the installation of an INSTEON RF receiver (such 
as an INSTEON AccessPoint).   

RemoteLincs link differently than other INSTEON devices, this require a separate linking 
routine.  To link a RemoteLinc to your ISY, click the LINK MANAGEMENT pulldown and 
choose LINK A REMOTELINC and follow the on-screen instructions.  Since the RemoteLinc 
is a battery-saving RF device, it must be put into linking mode whenever adding to the ISY 
or making changes (such as adding or removing from a scene).  To put the device in linking 
mode, hold Button 1 down for 10 seconds, or until the light starts flashing. 

To EXIT linking mode, either wait for the RemoteLinc to time out and the LED to stop 
flashing (4 minutes), or simply hit the BRIGHT or DIM button.  DO NOT hit one of the 6 
rocker buttons. 

RemoteLincs show up as a multiple nodes on the ISY (one node per button). 

Thermostat & Wireless Thermostat (2441TH / 2441ZTH) 
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There is a Program Action available to synchronize the Thermostat time with that of the 
ISY. 

Thermostat Adapter 

Older INSTEON Thermostat Adapters cannot act as Controllers, thus they do not notify the 
ISY of any state changes.  To get the most current information from your thermostat, we 
recommend using an ISY Program to poll the device periodically.  See Appendix G:  Sample 
ISY Programs. 

Newer Thermostat Adapters (V2) do notify the ISY of state changes, so a poll Program will 
not be necessary. 

TriggerLinc 

TriggerLincs are RF devices, thus require the installation of an INSTEON RF receiver (such 
as an INSTEON AccessPoint).   

The TriggerLinc cannot be linked using Auto Discover.  To link a TriggerLinc to the ISY, 
please choose the LINK MANAGEMENT pulldown, then NEW INSTEON DEVICE.  Enter the 
device address manually (found inside the battery compartment), then select the “2421 
TriggerLinc” from the Device Type list. 

Since the TriggerLinc is a battery-saving RF device, you must put the device into linking 
mode to add it to the ISY (and make any changes to the device, such as adding/removing 
from scenes).  Please follow the on-screen instructions to put the TriggerLinc into linking 
mode when prompted (hold SET button for 5 seconds). 

Once added to the ISY, the TriggerLinc will show up as 2 nodes.  The secondary node is only 
used when the TriggerLinc is in “Multi-Scene” mode.   

When in Normal mode, the TriggerLinc will send an ON command to the primary node 
when the sensor is open (magnet pulled away) and an OFF command when the sensor is 
closed (magnet close to sensor).   

When in Multi-Scene mode, the TriggerLinc will send an ON command to the first node 
when the sensor is open, and an ON command to the second node when the sensor is 
closed.  It will NOT send an OFF command to either node when in Multi-Scene mode. 
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Appendix G:  Sample ISY Programs 

This section contains some sample ISY Programs to get you started. 

Periodically poll your Thermostat Adapter: 

If 
        From    12:00:00AM 
        For      24 hours  
  
Then 
        Repeat Every  15 minutes  
           Wait  10 minutes  
           Set 'Thermostat' Query 
  
Else 
   - No Actions - (To add one, press 'Action') 

  

Front door light ON 20 minutes after sunset, OFF at 10pm: 

If 
        From    Sunset  + 20 minutes 
        To      10:00:00PM (same day) 
  
Then 
        Set Scene 'FrontDoor' On 
  
Else 
        Set Scene 'FrontDoor' Off 
  

Turn off closet light after 10 minutes: 

If 
        Status  'Closet' is not Off 
  
Then 
        Wait  10 minutes  
        Set 'Closet' Off 
  
Else 
   - No Actions - (To add one, press 'Action') 
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Notify you of extreme temperature conditions: 

If 
        Status  'Thermostat' > 90° (Temperature) 
     Or Status  'Thermostat' < 60° (Temperature) 
  
Then 
        Send Notification to All 
  
Else 
   - No Actions - (To add one, press 'Action') 

Turn driveway lights ON and OFF with an X10 remote: 

If 
        X10 'A2/On (3)' is Received 
    And X10 'A2/Off (11)' is not Received 
  
Then 
        Set Scene 'Driveway' On 
  
Else 
        Set Scene 'Driveway' Off 

Increase a counter called “LightCounter” whenever a particular light is switched on: 

If 
         Control 'Basement Light' is switched On 

Then 
           $LightCounter += 1 

  Else 
   - No Actions - (To add one, press 'Action') 

Send a notification email whenever the variable “LightCounter” reaches a value of 5, 
then reset it back to 0: 

If 
        $LightCounter is 5 

  Then 
  Send Notification to 'My Email' 
  $LightCounter  = 0 

Else 
         - No Actions - (To add one, press 'Action') 
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Appendix H:  Troubleshooting INSTEON Communication 
Issues 

It is important to have a pair of INSTEON AccessPoints or other INSTEON RF devices (or an 
INSTEON-compatible hardwired coupler) installed to ensure good communications 
between both legs of power in your home.  See Smarthome’s documentation for ensuring 
your AccessPoints are installed on opposite legs of power.  We recommend placing them as 
close to your electrical panel as possible. 

An AccessPoint (or other INSTEON RF receiver, such as their 2413S Dual-Band PLM) is also 
required to communicate with INSTEON RF devices. 

Most INSTEON devices use powerline technology to communicate with one another.  Some 
devices on in your home may interfere with device communications.  Some known 
offenders are: 

 Low voltage lighting 
 Fluorescent lighting 
 CFLs 
 Desktop computers and notebooks 
 Surge protectors 
 UPSs 

In many cases these devices can exist on your powerline with no problem.  But, if you are 
experiencing communication issues, we highly recommend unplugging any devices you 
have on the above list.  Once you establish reliable communications, add the devices back in 
one at a time to find the cause.  Most troublesome plug-in devices can be filtered using 
FilterLincs from Smarthome. 

Because the ISY sends and receives all INSTEON signals through the PLM, we highly 
recommend plugging it in to an outlet away from potentially noisy electrical devices, such 
as PCs and UPSs, and as close to your electrical panel as possible.  DO NOT plug your PLM 
into a surge protector or UPS.  We also highly recommend installing an AccessPoint as close 
to your PLM as possible. 


